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HARDWARE WARRANTY

Tektronix warrants that the products that it manufactures and sells will be free from defects in materials and workmanship
for a period of one (1) year from the date of shipment. If a product proves defective during this warranty period, Tektronix,
at its option, either will repair the defective product without charge for parts and labor, or will provide a replacement in
exchange for the defective product.

In order to obtain service under this warranty, Customer must notify Tektronix of the defect before the expiration of the
warranty period and make suitable arrangements for the performance of service. Customer shall be responsible for
packaging and shipping the defective product to the service center designated by Tektronix, with shipping charges prepaid.
Tektronix shall pay for the return of the product to Customer if the shipment is to a location within the country in which the
Tektronix service center is located. Customer shall be responsible for paying all shipping charges, duties, taxes, and any
other charges for products returned to any other locations.

This warranty shall not apply to any defect, failure or damage caused by improper use or improper or inadequate
maintenance and care. Tektronix shall not be obligated to furnish service under this warranty a) to repair damage resulting
from attempts by personnel other than Tektronix representatives to install, repair or service the product; b) to repair
damage resulting from improper use or connection to incompatible equipment; ¢) to repair any damage or malfunction
caused by the use of non-Tektronix supplies; or d) to service a product that has been modified or integrated with other
products when the effect of such modification or integration increases the time or difficulty of servicing the product.

THIS WARRANTY IS GIVEN BY TEKTRONIX IN LIEU OF ANY OTHER WARRANTIES, EXPRESS OR
IMPLIED. TEKTRONIX AND ITS VENDORS DISCLAIM ANY IMPLIED WARRANTIES OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. TEKTRONIX” RESPONSIBILITY TO
REPAIR OR REPLACE DEFECTIVE PRODUCTS IS THE SOLE AND EXCLUSIVE REMEDY PROVIDED TO
THE CUSTOMER FOR BREACH OF THIS WARRANTY. TEKTRONIX AND ITS VENDORS WILL NOT BE
LIABLE FOR ANY INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES IRRESPECTIVE
OF WHETHER TEKTRONIX OR THE VENDOR HAS ADVANCE NOTICE OF THE POSSIBILITY OF SUCH
DAMAGES.



SOFTWARE WARRANTY

Tektronix warrants that the media on which this software product is furnished and the encoding of the programs on the
media will be free from defects in materials and workmanship for a period of three (3) months from the date of shipment.
If a medium or encoding proves defective during the warranty period, Tektronix will provide a replacement in exchange
for the defective medium. Except as to the media on which this software product is furnished, this software product is
provided “as is” without warranty of any kind, either express or implied. Tektronix does not warrant that the functions
contained in this software product will meet Customer’s requirements or that the operation of the programs will be
uninterrupted or error-free.

In order to obtain service under this warranty, Customer must notify Tektronix of the defect before the expiration of the
warranty period. If Tektronix is unable to provide a replacement that is free from defects in materials and workmanship
within a reasonable time thereafter, Customer may terminate the license for this software product and return this software
product and any associated materials for credit or refund.

THIS WARRANTY IS GIVEN BY TEKTRONIX IN LIEU OF ANY OTHER WARRANTIES, EXPRESS OR
IMPLIED. TEKTRONIX AND ITS VENDORS DISCLAIM ANY IMPLIED WARRANTIES OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. TEKTRONIX’ RESPONSIBILITY TO
REPLACE DEFECTIVE MEDIA OR REFUND CUSTOMER’S PAYMENT IS THE SOLE AND EXCLUSIVE
REMEDY PROVIDED TO THE CUSTOMER FOR BREACH OF THIS WARRANTY. TEKTRONIX AND ITS
VENDORS WILL NOT BE LIABLE FOR ANY INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL
DAMAGES IRRESPECTIVE OF WHETHER TEKTRONIX OR THE VENDOR HAS ADVANCE NOTICE OF
THE POSSIBILITY OF SUCH DAMAGES.
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General Safety Summary

Review the following safety precautions to avoid injury and prevent damage to
this product or any products connected to it. To avoid potential hazards, use this
product only as specified.

Only qualified personnel should perform service procedures.

To Avoid Fire or ~ Use Proper Power Cord. Use only the power cord specified for this product and
Personal Injury  certified for the country of use.

Connect and Disconnect Properly. Do not connect or disconnect probes or test
leads while they are connected to a voltage source.

Ground the Product. This product is grounded through the grounding conductor
of the power cord. To avoid electric shock, the grounding conductor must be
connected to earth ground. Before making connections to the input or output
terminals of the product, ensure that the product is properly grounded.

Observe All Terminal Ratings. To avoid fire or shock hazard, observe all ratings
and marking on the product. Consult the product manual for further ratings
information before making connections to the product.

The common terminal is at ground potential. Do not connect the common
terminal to elevated voltages.

Do not apply a potential to any terminal, including the common terminal, that
exceeds the maximum rating of that terminal.

Use Proper AC Adapter. Use only the AC adapter specified for this product.

Do Not Operate Without Covers. Do not operate this product with covers or panels
removed.

Use Proper Fuse. Use only the fuse type and rating specified for this product.

Avoid Exposed Circuitry. Do not touch exposed connections and components
when power is present.

Do Not Operate With Suspected Failures. If you suspect there is damage to this
product, have it inspected by qualified service personnel.

Do Not Operate in Wet/Damp Conditions.
Do Not Operate in an Explosive Atmosphere.
Keep Product Surfaces Clean and Dry.

Provide Proper Ventilation. Refer to the manual’s installation instructions for
details on installing the product so it has proper ventilation.
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Symbols and Terms

Terms in this Manual. These terms may appear in this manual:

WARNING. Warning statements identify conditions or practices that could result
in injury or loss of life.

/N
/N

CAUTION. Caution statements identify conditions or practices that could result in
damage to this product or other property.

Terms on the Product. These terms may appear on the product:

DANGER indicates an injury hazard immediately accessible as you read the
marking.

WARNING indicates an injury hazard not immediately accessible as you read the
marking.

CAUTION indicates a hazard to property including the product.

Symbols on the Product. The following symbols may appear on the product:

A\ S VAN m

WARNING Protective Ground CAUTION Double
High Voltage (Earth) Terminal Refer to Manual Insulated

Tektronix Logic Analyzer Family User Manual, Version 4.2 Software



Preface

This manual contains operating information for the Tektronix Logic Analyzer
family. The manual consists of the following sections:

Getting Started. Provides basic information about installing and using the
logic analyzer.

Operating Basics. Provides an overview of the logic analyzer connectors,
introduces you to the logic analyzer and pattern generator windows, and
explains the basic operation of the Tektronix Logic Analyzer.

Reference. Provides detailed information of the logic analyzer. This section
is divided according to the window types.

Appendix A: Specifications. Lists the environmental, physical, and electrical
properties of the logic analyzer family.

Appendix B: TLA700 Symbol File Format. Provides information about the
contents of symbol files using the TLA700 Symbol File format.

Appendix C: PG Physical-Logical Conversion. Provides information on
using signals between the LA module, DSO module, and the PG module.

Appendix D: TLA700 Module Installation. Provides installation instructions
for logic analyzer modules. Refer to this appendix if you need to install
modules in the TLA700 mainframes.

Appendix E: Merging Modules. Provides instructions for merging modules to
create wider mainframes for specific applications.

Appendix F: Power Cord and Line Fuse Requirements for the Benchtop and
Expansion Mainframes. Provides information on the power and fuse
requirements for the benchtop and expansion mainframes.

Appendix G: Installing Software. Provides instructions for reinstalling the
system and application software and firmware.

Appendix H: User Service. Provides user service information.
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Related Documentation

In addition to this user manual, the following documentation is available for your
Tektronix logic analyzer:

The online help provides information about the user interface, the TLA700
Programmatic Interface (TPI), and the TLAScript interface. To view the
online help, select Help Topics from the Help menu. The TLAScript online
help provides links to related topics in TPI.

The TLA7PG2 online help provides information about the pattern generator
user interface and the Pattern Generator Programmatic Interface (PPI). To
view the online help, select Help Topics from the Help menu in the
TLA7PG?2 application.

The online release notes provide last-minute product and software informa-
tion not included in this manual. Refer to Release Notes on page 1-33 for
information on viewing the release notes.

A series of microprocessor support instruction manuals provide operating
and service instructions for the individual microprocessor support packages.

The TLA7QS QuickStart Training Manual provides training exercises to help
you learn key features of the logic analyzer. The training manual is designed
to be used with the TLA7QS QuickStart training board.

A series of service manuals provide board-level service information for the
logic analyzer modules and mainframes.

A series of probe manuals provide detailed instructions for using individual
logic analyzer and pattern generator probes.

A series of probe labeling instructions provide detailed instructions for
labeling the P6810, P6860, and P6880 logic analyzer probes.

Terms Used in this Manual

The following terms are used throughout this manual. Refer to the Glossary for
information on other logic analyzer terminology.

LA Module. An abbreviation and generic term for the logic analyzer
module.

DSO Module. An abbreviation and generic term for the oscilloscope
module.

PG Module. An abbreviation and generic term for the pattern generator
module.
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What’s New in This Manual

The Tektronix Logic Analyzer family consists of the TLA600 and TLA700
series logic analyzers, and all of the accessories and supports that can be used
with them. This manual includes information on product enhancements, new
features, and information on using these to improve your instrument performance
and reliability. Specifically, this manual has been updated to include information
on the new TLA7Axx logic analyzer modules for the TLA700 series, which
have:

® 8 GHz MagniVu Timing acquisition. You now have 8 GHz MagniVu
timing acquisition available on all channels with 16 Kb memory depth per
channel. You can view any channel with 125 ps timing resolution to verify
digital signal timing. Additional capabilities include adjustable sample rate
(125 ps to 1 ns), movable trigger position, and a separate MagniVu trigger
action that can be triggered independent of the main module trigger.
Minimum detectable pulse widths of 750 ps can be acquired and triggered
upon using the MagniVu acquisition technology.

® 2 GHz deep Transitional Timing acquisition. To capture elusive digital
signal timing problems over long time spans, 2 GHz deep time acquisition is
available with up to 256 MB memory depth on quarter-channels. 1 GHz deep
timing is available on half-channels and 500 MHz deep timing is provided
on all channels. Transitional storage is used to only store when data changes
and is timestamped with 125 ps resolution.

® 120 to 800 MHz State acquisition. To enable tracing data flow and program
execution of processors and buses 120 to 800 MHz state acquisition is now
available. Three state acquisition speeds are provided: 120 MHz (standard),
235 MHz (optional) and 450 MHz (optional) to fit a wide range of processor
and bus applications. A comprehensive set of clocking capabilities provide
the means to work with virtually any processor or bus including support for
high-speed data rates. Plus, advanced support is provided for source
synchronous buses to simplify setup and acquisition. A setup/hold window
of 650 ps provides accurate data capture from the fastest processors and
busses. The window is adjustable in 125 ps increments within a range from
+16 ns to -8 ns.

®  Triggering. Enhancements include a trigger state machine that operates at a
2 ns rate with trigger resources that include 16 states, 16 words/4 range
recognizers, two 51-bit counter/timers and 16 transition (edge) recognizers.
A key benefit of the MagniVu acquisition technology is that it provides a
500 ps glitch recognizer and a 250 ps setup/hold violation both with 125 ps
resolution up to a 16 ns window. A comprehensive set of trigger actions
including storage control and sequence actions is also provided. Additional
triggering enhancements include a decrement counter function, a force prefill
function (used to ensure that memory is fulled before looking for the trigger)
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and a Snapshot Recognizer. In the External 2X/4X modes, events up to the
maximum data rate of 1.25 Gb/s can be used for triggering.

128 KB to 64 MB Memory Depth. Increased memory depth enables
triggering on the symptom of a problem and capturing the cause when they
are widely separated in time. Memory depth configurations of 128 KB, 512
KB, 2 MB, 8 MB, and 64 MB are available. Another benefit of the MagniVu
acquisition technology is the separate 51-bit, 125 ps resolution time stamp
memory that provides automatic and accurate time-correlation over a 3.25
day duration with data from any other module with a typical correlation
accuracy of 2 ns.

2.0 GHz Analog Multiplexer. Routes the analog signal of any four logic
analyzer channels to either an internal or external DSO, eliminating the need
to double-probe signals. Using iView, data from an external DSO can be
correlated on the TLA display to quickly track down elusive digital signal
quality problems.

Low-Capacitance, Connectorless Smart Probing System. This system
combines analog and digital measurements through a single probe connec-
tion, providing immediate analog measurements access to all digital signals.
Both high-density and general-purpose probes are available and feature an
ultra-low 0.7 pF (1.0 pF for GP probes in group configuration) and 1.0 pF
total probe input capacitance, respectively. Single-ended and differential
logic signals are supported as well. Each probe is a smart probe that, once
calibrated, maintains its own individual calibration constraints (deskew,
input resistance, and gain/offset) in the probe’s internal NVRAM. When
plugged into the new TLA7Axx logic analyzer module, the probe calibration
constants are loaded and used to provide more accurate measurements.

5-Way Module Merging. This increases the maximum channel count to
680 channels on a single timebase with no tradeoff in performance, thereby
allowing the TLA7Axx to be used for the deepest and widest applications.
For state applications, you can get up to 340 channels at 128 M depth, at
800 MHz (External 2X) or 170 channels at 258 M depth, at 625 MHz
clock/1.25 Gb/s data (External 4X). For deep transitional timing applica-
tions, you can get up to 340 channels at 128 M depth, at 1 GHz (Internal 2X)
or 170 channels at 256 M depth, at 2 GHz (Internal 4X).

Calibration Fixture. The TLACAL?2 calibration fixture provides you with
the tools to keep your new TLA7Axx logic analyzer module operating at
maximum performance for the most accurate measurements. It also provides
you with performance verification and adjustment procedures, including
traceable calibration.

New CD-RW Drive. All new TLA60x/61x/62x instruments and
TLA715/721 mainframes now come standard with a CD-RW drive that
allows you to back up and transport your large setup and data files.
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®  iView Integrated View of Your TDS Data on Your TLA Display.
Introduced as part of Version 4.1 TLA Application Software, iView has now
been enhanced to include support for the TDS3000/3000B, TDS5000,
TDS6000, TDS7000, CSA7000 TDS600C and TDS700 Series oscillo-
scopes.

m  EasyTrigger. Introduced as part of Version 4.1 of the TLA Application
Software, EasyTrigger has now been enhanced to include support for the
TLA7Axx logic analyzer module and its new triggering capabilities.
Examples include snapshot recognizer, demux 2X/4X, decrement counter, 16
transition (edge) recognizers and independent MagniVu trigger.

®  Version 4.2 TLA Application Software. Newest version of TLA600/700
application software has been enhanced to support the TLA7Axx logic
analyzer module and requires Windows 2000 Professional (Windows 2000
Service Pack 2 is now standard). Your existing TLA60x/61x/62x instrument
or TLA715/721 mainframe can easily be upgraded to Version 4.2 with the
appropriate TLA6UP or TLA7UP Field Upgrade Kits. All existing TLA
setup and data files are fully forward-compatible with Version 4.2 TLA
application software. Version 1.3 of the PatGen Application software and
PatGenVu are also included.
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Contacting Tektronix
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Phone 1-800-833-9200%

Address Tektronix, Inc.
Department or name (if known)
14200 SW Karl Braun Drive

P.O. Box 500

Beaverton, OR 97077

USA
Web site www.tektronix.com
Sales support 1-800-833-9200, select option 1*
Service support 1-800-833-9200, select option 2%

Technical support Email: techsupport@tektronix.com
1-800-833-9200, select option 3*
6:00 a.m. - 5:00 p.m. Pacific time

*  This phone number is toll free in North America. After office hours, please leave a
voice mail message.
Outside North America, contact a Tektronix sales office or distributor; see the
Tektronix web site for a list of offices.
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The Tektronix Logic Analyzer family consists of the TLA600 and TLA700
series logic analyzers, and all of the accessories and supports that can be used
with them. For more information about availability, contact your Tektronix
representative and view the Tektronix website at: www.tektronix.com.

TLAG600 Series Logic Analyzers

The TLA600 logic analyzers are a high-performance line of logic analyzers.
There are two basic styles: one contains an internal display, and the other uses an
external display as shown in Figure 1-1. The TLA600 logic analyzers offer a
variety of channel widths and memory depths.

Internal and

external display External

display only

Figure 1-1: TLA600 series logic analyzers

MagniVu is an acquisition technology that provides up to 1000 picosecond
timing resolution on all channels and requires no additional probing.

Tektronix Logic Analyzer Family User Manual, Version 4.2 Software 1-1



Getting Started

TLA700 Series Logic Analyzers

1-2

The TLA700 series logic analyzers combine a high-performance logic analyzer
module with an optional digitizing storage oscilloscope (DSO) module and
pattern generator module.

There are two styles of mainframes: portable and benchtop. Each mainframe can
also include an expansion mainframe that looks similar to the benchtop
mainframe and is compatible with both the portable and benchtop mainframes.
The portable mainframe and the benchtop mainframe are shown in Figure 1-2
and Figure 1-3.

Several logic analyzer modules are available in various combinations of channel
width and memory depth. All of the logic analyzer modules provide simulta-
neous state and timing measurements through a single probe.

MagniVu, an acquisition technology enabled by the logic analyzers, provides a
sampling rate of 500 ps on TLA7Lx/Mx/Px/Qx modules and 125 ps on
TLA7Axx modules on all channels without additional probing.
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Figure 1-2: TLA700 portable mainframe
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Accessories

Expansion
mainframe

Benchtop
mainframe

Figure 1-3: TLA700 benchtop mainframe with an expansion mainframe

The DSO module enables digital real-time signal acquisition. Data acquired
using this module is time correlated with data from other modules for displays
and intermodule triggering and signalling.

The pattern generator module provides multi-channel signals for use in applica-
tions such as simulation of missing system elements, erroneous signals for stress
testing, and extended analysis for stimulating a device under test.

The Windows operating system allows you to install any PC-compatible,
third-party hardware and software on the instrument.

For a complete list of accessories, refer to the online help. Select the Contents
tab and click the Standard and Optional Accessories icon. Then select one of the
topics for more information.
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Installation

Check the Shipping List

1-4

Site Considerations

/N

This section describes the steps needed to install your Tektronix logic analyzer.

Verify that you have received all of the parts of your logic analyzer using the
shipping list. You should also verify the following:

B Verify that you have the correct power cords for your geographical area.

®m  Verify that you have backup copies of the installed software. Store the
backup software in a safe location where you can easily retrieve the software
for maintenance purposes.

®m  Verify that you have the correct probes and adapters (and modules if you
have a TLA700 series logic analyzer).

®m  Verify that you have all the standard and optional accessories that you
ordered.

NOTE. Keep the software packaging available because you will need it to enter
the Windows software registration number when you first turn on the logic
analyzer.

®  Fill out and return the customer registration card that is packaged with this
manual.

Read this section before installing the logic analyzer. This section describes site
considerations, power requirements, and ground connections for your logic
analyzer.

CAUTION. Allow a two inch (5.1 cm) clearance at the bottom and sides of the
instrument to ensure proper cooling.

TLA600 and TLA714/715 Logic Analyzers. You can use the TLA600 and TLA715
logic analyzers on a bench or on a cart in the normal position (on the bottom
feet).

You can also use the logic analyzer while it rests on the rear feet. If you use the
instrument while it is resting on the rear feet, make sure that you properly route
any cables connected to the rear of the instrument to avoid damaging them.
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VAN

TLA720/721 Benchtop and TLA7XM Expansion Mainframes. The benchtop and
expansion mainframes are designed to operate on a bench or in a rackmount
environment.

WARNING. To avoid personal injury, do not stack more then one expansion
mainframe on top of a benchtop mainframe or another expansion mainframe.
Always use a rackmount kit to ensure that the expansion mainframes are secure
and will not fall.

If you need to stack more than two benchtop and expansion mainframes, install
the mainframes in a rack. Rackmount kits are available from third-party vendors.
Please refer to the online help under Standard and Optional Accessories for
rackmount kit part numbers.

WARNING. To avoid personal injury, never lift or move a benchtop or expansion
mainframe by yourself. The size and weight of these mainframes requires two
people to lift or move them.

Installing Expansion Mainframes

VAN

Installing in a benchtop
Mainframe

This section describes how to install a TLA7XM expansion mainframe. If your
logic analyzer does not contain any expansion mainframes, you can skip this
section. Observe the following guidelines when installing expansion mainframes:

B Do not stack more than one mainframe on top of another mainframe without
a rackmount Kkit.

®m  The expansion module must be installed in slot O of the expansion main-
frame.

CAUTION. Verify that all mainframes are powered off before continuing the
installation procedure. If you are installing more than two expansion main-
frames, always use a rackmount kit. Contact your local Tektronix representative
for information on site considerations for multiple mainframes.

The expansion module can be installed in any slot of the benchtop mainframe
except 0 through 2, which are reserved for the benchtop controller module. If
you are only installing one expansion mainframe, you can install the expansion
module in slot 12 to keep the expansion cables out of your way.
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1-6

VAN

If you are installing two expansion mainframes, consider installing the two
expansion modules next to the benchtop controller module to maximize the
number of open slots as shown in Figure 1-5 on page 1-7.

You can configure up to four expansion mainframes with the portable mainframe
and up to ten expansion mainframes with a benchtop mainframe.

To install the expansion module:

1. If the expansion module is not already installed in slot 0 of your expansion
mainframe, install it now (refer to Appendix D: TLA700 Module Installation
for detailed module installation instructions).

CAUTION. To avoid damaging the chassis, do not use the retaining screws to seat
the expansion module. These screws are intended for securing the module and
reinforcing the grounding.

2. Manually seat the expansion module by pressing it into place.

3. Use a screwdriver to tighten the retaining screws (maximum of 2.5 in-Ibs).

Benchtop mainframe Expansion mainframe
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Figure 1-4: Benchtop mainframe and one expansion mainframe

4. Place the EXPANSION 1 label in the outlined area on the upper right side of
the expansion mainframe.
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Expansion mainframes

Benchtop mainframe Expansion mainframes
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Figure 1-5: Benchtop mainframe

Installing in a TLA714/715
Mainframe

VAN

and two expansion mainframes

When you install two expansion mainframes, software determines which
expansion chassis is expansion 1 and which is expansion 2 by the order in which
you install the expansion modules in the benchtop mainframe. The expansion
module in the lower numbered slot will be expansion 1, and the expansion
module in the higher slot will be expansion 2.

For the setup in Figure 1-5, place the EXPANSION 1 label in the outlined area
on the upper right side of the expansion mainframe to the left of the benchtop
mainframe. Place the EXPANSION 2 label in the outlined area on the upper right
side of the expansion mainframe to the right of the benchtop mainframe.

For information on installing modules see TLA700 Module Installation
beginning on page D-1.

The expansion module can be installed in any slot of the portable mainframe. If
you are installing one or two expansion mainframes, you can install the
expansion module in slot 1 as shown in Figure 1-6.

If the expansion module is not already installed in slot O of your expansion
mainframe, install it now.

CAUTION. To avoid damage to the chassis, do not use the retaining screws to seat
the expansion module. These screws are intended for securing the module and
reinforcing the grounding. Manually seat the expansion module by pressing it
into place, and then secure it using the retaining screws.

After seating the modules in place, use a screwdriver to tighten the retaining
screws (maximum of 1.0 in-Ibs).
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Expansion mainframe Expansion mainframe
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Figure 1-6: Portable mainframe shown with two expansion mainframes

Software determines which expansion chassis is expansion 1 and which is
expansion 2 by the order in which the expansion modules are installed. The
expansion module in the lower numbered slot will be expansion 1, and the
expansion module in the higher slot will be expansion 2.

For the setup in Figure 1-6 place the EXPANSION 1 label in the outlined area
on the upper right side of the expansion mainframe to the left of the portable
mainframe. Place the EXPANSION 2 label in the outlined area on the upper right
side of the expansion mainframe to the right of the portable mainframe.

For information on installing modules see TLA700 Module Installation
beginning on page D-1.

Installing the Expansion  There are three cables that connect the expansion modules together. To connect
Cables the expansion modules together, perform the following procedure:

1. Examine the gray expansion cable to determine if the connectors have labels.
If the connectors are not labeled, apply the C labels to each connector.

2. Connect one end of the gray expansion cable to connector C of the expansion
module on the expansion mainframe side. Connect the other end of the gray
expansion cable to connector C of the expansion module on the benchtop or
portable mainframe side.

3. Fasten the expansion cable connector to the expansion module by tightening
the two hold-down screws.

4. Examine the two blue expansion cables to determine if the connectors are
labeled A and B.
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a. If the cables are labeled A and B, select the B cable and proceed to
step 5.

b. If the cables are not labeled, select either blue expansion cable and label
each connector with the B label. Select the other cable and apply the
A labels to each connector.

5. Connect one end of the blue expansion cable to connector B of the expansion
module on the expansion mainframe side. Connect the other end of the blue
expansion cable to connector B of the expansion module on the benchtop or
portable mainframe side.

6. Fasten the expansion cable connector to the expansion module by tightening
the two hold-down screws.

7. Connect one end of the blue expansion cable to connector A of the expansion
module on the expansion mainframe side. Connect the other end of the blue
expansion cable to connector A of the expansion module on the benchtop or
portable mainframe side.

8. Fasten the expansion cable connector to the expansion module by tightening
the two hold-down screws.

Installing TLA700 Modules

To install additional modules for the TLA700 series logic analyzers, refer to
Appendix D: TLA700 Module Installation for detailed instructions.

Connecting Accessories

After installing the mainframes and modules, you can connect the accessories
such as external monitors, keyboard, and printer.
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Connecting Accessories  The accessory connections are the same as those you would make on a personal
y y p
to the TLA600 Series  computer. Connect the accessories to the rear of the instrument. The connection
points are shown in Figure 1-7.

Description......................... Icon/Label Locations

Monitor............... SVGA OUT @

El
Printer. LPT

RS-282... com 1 I010]]

Network........ceeeeveeeerennnne %

MOUSE......oveerreeereeereae
Keyboard.............cccoocen
usB g
Audio Line Out =
Audio Line In ﬁ
CD DIIV8.cre disc —l
| i
O = 1 2/
[ —
s G —

SVGAOUT @

000 === ,%'. @ % cou 1 [OIO1)
B} 0.0 =500
PC CARD

- Jd)10000 =4

i
i

EXTERNAL SIG OUT
EXTERNAL SIG IN
SYSTEM TRIG OUT
SYSTEM TRIG IN

PC CARD
Card Slot........... TYPE2/TYPE 3

Figure 1-7: TLA600 series accessories connections
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Connecting Accessories  The accessory connections are the same as those you would make on a personal
to the TLA700 Series = computer. The connection points are shown in Figure 1-8. Use the icons that
appear in the circled areas as a guide.

Icon Description

Primary
video

=

Secondary
video

UaQd

ANARSARERARNNRRRRNNNNRNNNY

e

|IOIC| | RS-232

SN

A LN

Printer

usB

2
¢
% Mouse

Keyboard

Floppy
QE disk drive

—— PC card
(LAN or other)

Figure 1-8: TLA700 series accessories connections

NOTE. Only TLA715/721 instruments have both primary and secondary video
outputs. TLA714/720 instruments are equipped with only one video output.
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Additional Accessory  Table 1-1 provides additional information on accessories.

Connection Information

Table 1-1: Additional accessory connection information

ltem

Description

Monitor

If you use a non-standard monitor, you may need to change the
the Windows display settings to achieve the proper resolution.

Printer

Connect the printer to the ECP (enhanced parallel port)
connector directly. If your printer has a DB-25 connector, use
the adapter cable that came with your logic analyzer to connect
to the ECP connector.

Connecting Probes

Once you have connected all the accessories, you can connect the probes to the
instrument. Refer to the appropriate section for your instrument.

For additional information on the individual probes, refer to the instructions that
accompanied your probes.

CAUTION. When attaching the probe to the logic analyzer, you must use care to

A evenly tighten probe screws until they are snug. First slightly tighten screws,
then snug each screw to 4 in-Ibs (max). Under tightening the probe screws can
result in intermittence. Over tightening can result in stripped screws.
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Connecting Probes tothe  Connect the logic analyzer probes and the optional retaining brackets as shown
TLA600 Logic Analyzer  in Figure 1-9.

Attach optional probe
retainer brackets

Match color-coded
labels

Figure 1-9: Connecting the logic analyzer probes to a TLA600 logic analyzer
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Connecting Probes tothe  Connect the logic analyzer probes and the optional retaining brackets as shown
TLA700 LA Module  in Figure 1-10 and Figure 1-11 .

p
B S

Q

Match color-coded labels

R
7 \
e
|
\‘ w’/
\‘P N Attach optional

probe retainer
brackets

Figure 1-10: Connecting the logic analyzer probes to the TLA7Lx, TLA7Mx, TLA7NX,
TLA7Px, and TLA7Qx modules
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Match
color-coded
labels

Figure 1-11: Connecting the logic analyzer probes to the TLA7Axx module

Configuring the Pattern  Some of the TLA Pattern Generator probes require series termination resistors to
Generator Probe  provide impedance matching for the pattern generator and the system under test.
Determine the impedance matching for your application, and then refer to the
TLA7PG2 Probe Instruction Manual for information about how to change the
series termination resistors.

Connecting the Pattern ~ Power down the logic analyzer before connecting the pattern generator probe.

Generator Probes
Connect the pattern generator probe as shown in Figure 1-12. The probe cable is

reversible. You can connect the probe cable in either direction.

CAUTION. To prevent damage to the pattern generator module or probe, do not
connect or disconnect the probe cables while the logic analyzer is powered on.

Although the pattern generator probe cable appears to be a SCSI cable, it is not
compatible with a SCSI cable; do not use a SCSI cable with the pattern
generator module, or use the pattern generator probe cable with a SCSI
instrument.

The probe is fragile, handle carefully.
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First Time Operation

Figure 1-12: Connecting the pattern generator probes

The first time your logic analyzer is turned on, you will see a TLA Final Setup
icon on your desktop. Double-click the icon to launch the application for the
first time. The TLA application will automatically start every time you power on
the instrument.

If you have a TLA700 series logic analyzer with a pattern generator software and
module installed, the pattern generator application will also automatically start.

Turning On the TLA600 Series Logic Analyzer

Follow these steps to turn on the logic analyzer for the first time:

CAUTION. Connect the keyboard, mouse, and other accessories before applying
power to the logic analyzer.

Connecting the accessories after turning on the logic analyzer can damage the
accessories.

1. Check that the line fuses are correct for your application. The instrument
uses two fuses; both fuses must be the same. See Table 1-2.
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Table 1-2: TLA600 series line fuses

Line voltage Rating Tektronix part number
90 Vto 132 V operation 8 A, fast blow, 250 V 159-0046-xx
207 V to 250 V operation 6.3 A, fast blow, 250 V 159-0381-xx

2. Connect the power cord. See Figure 1-13.

3. If you have an external monitor, connect the power cord and turn on the
monitor.

ﬂ: =1 Q

oo=8d
Mg

B W
TIQOET

Power Fuse AC Power
Switch (2 required)

Figure 1-13: Line fuse and power cord connector locations

4. Turn on the logic analyzer as follows:

a. Press the On/Standby switch to turn on the logic analyzer (see
Figure 1-14 for the switch location).

b. Wait for the logic analyzer to complete power-on self-tests, start
Windows, and start the TLA application.
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Figure 1-14: On/Standby switch locations

Turning On the TLA700 Series Logic Analyzer

VAN

Follow these steps to turn on the logic analyzer for the first time:

CAUTION. To avoid damaging the accessories, connect the keyboard, mouse, and

other accessories before applying power to the mainframe.

1. Check that the line fuse is correct for your application. See Table 1-3.

2. Connect the power cord. See Figure 1-15.

3. If you have an external monitor, connect the power cord and turn on the

monitor.

Table 1-3: TLA700 series line fuses

Line voltage Rating Tektronix part number
Portable mainframe

90 V to 132 V operation 8 A, fast blow, 250 V 159-0046-xx

207 V to 250 V operation 6.3 A, fast blow, 250 V 159-0381-xx

Benchtop mainframe

90 V to 132 V operation 20 A, slow blow, 250 V 159-0379-xx

103 V to 250 V operation 15 A, fast blow, 125 V 159-0256-xx

207 V to 250 V operation 6.3 A, fast blow, 250 V 159-0381-xx
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AC power and fuse

Figure 1-15: Line fuse and power cord connector locations

or more modules in your mainframe, you must determine the correct fuse and
power cord combination.

é CAUTION. To avoid overloading the power distribution system, if you have four

Although the benchtop mainframe can use the power cord with the 15 A plug,
mainframes operating at low line (90 VAC) with four or more instrument
modules may require the power cord with the 20 A plug.

See Appendix F: Power Cord and Line Fuse Requirements for the Benchtop
Mainframe for further information.

4. Turn on the mainframe as follows:

a. Press the On/Standby switch to turn on the mainframe (see Figure 1-16
for the switch location).

b. Wait for the mainframe to complete power-on self-tests, start Windows,
and start the TLA700 application.
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Figure 1-16: On/Standby switch locations

Powering On the Mainframes

The expansion mainframe automatically powers on when the connected benchtop

or portable mainframe powers on. If everything is properly connected and
operational, you will see the expansion mainframe and the installed modules in

the System window.

If the expansion mainframe and the installed modules do not display in the
System window, see Table H-1 beginning on page H-10 for troubleshooting
suggestions.

NOTE. You must have a module installed in the expansion mainframe before the
expansion mainframe is recognized by the resource manager and appears in the

System window.

Turning Off the TLA700 Series Mainframe

1-20

Both the TLA714/715 portable mainframe and the TLA720/721 benchtop
mainframe have a built-in soft power-down function that safely powers down the

mainframe when you press the On/Standby switch.

The expansion mainframe automatically powers down when the benchtop or
portable mainframe is turned off.
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Performing the Incoming Inspection

Incoming inspection consists of verifying the basic operation of the logic
analyzer. The power-on diagnostics check the basic functionality. These
diagnostics run every time you turn on the logic analyzer.

You can also verify more detailed functionality by running the self calibration
and extended diagnostics.

NOTE. Allow the mainframe and modules to warm up for 30 minutes before
running the self calibration.

To run self-calibration and diagnostics, perform the following:
1. Disconnect any probes attached to the modules.
2. Select the System menu and point to Calibration and Diagnostics.

3. Run the self calibration followed by the extended diagnostics by selecting
the proper tab. Results of the tests display on the individual property page.

To run self calibration and external diagnostics for a pattern generator, perform
the following:

1. Select the Pattern Generator System menu and point to Calibration and
Diagnostics.

2. Run the self calibration followed by the extended diagnostics by selecting
the proper tab. Results of the tests display on the individual property page.

NOTE. The time required to run the self calibration on the logic analyzer
modules depends on the number of acquisition channels. Modules with a large
number of channels may take several minutes to run the self calibration.

Checking the Logic  Connect the logic analyzer probes to a signal source, start an acquisition, and
Analyzer Probes  verify that the acquired data is displayed in either the listing or waveform

(0ptiona|) windows.

NOTE. If you connect probes to any channels other than the A2 and A3 groups,
you must define the groups and channels in the Setup window before acquiring
data on other probe channels.
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Checking the DSO Probes
(Optional)

Checking the Pattern
Generator Probes
(Optional)

Checking the Mainframe
(Optional)

Checking the P68xx
Probes

Backing Up User Files

1-22

Connect the oscilloscope probes to the Probe Compensation connector on the
front panel of the DSO module. You can then run the Calibrate Probe function in
each vertical setup page for the module.

Set up a simple pattern generator program to output a signal to the probes.
Connect an oscilloscope probe to the probe outputs and verify that the signal is
present at the probe outputs.

To check the mainframe diagnostics not covered by the TLA Application
software, run the TLA700 Mainframe Diagnostics located under the Windows
Start menu under the Tektronix TLA700 programs. Exit the TLA Application
before running the external diagnostics.

To check the P68xx probes, connect the probes to a signal source, start an
acquisition, and verify that the acquired data is displayed in either the listing or
waveform windows.

If available, use the TLACALZ2 fixture to run the performance verification. For
further details, refer to the performance verification procedure in the 7TLA7Axx
Logic Analyzer Module Service Manual.

Back up your user files on a regular basis. Use the Windows back up tools or
copy the files to floppy disks, to a network drive, or to another media. Always
keep a backup copy of files that you access on a regular basis.
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Removing the Replaceable Hard Disk Drive (TLA700 Series Only)

é CAUTION. To avoid permanently damaging the hard disk drive, do not remove it

while the instrument is powered on. Always power down the instrument before
removing the hard disk drive.

1. Verity that the instrument is turned off.

2. Remove the replaceable hard disk drive cartridge by depressing it to release
the latch.

3. Pull on the replaceable hard disk drive cartridge to remove it from the
chassis. Figures 1-17, 1-18, and 1-19 show the procedures for removing the
hard disk drive for the benchtop controller and for the portable mainframe.

NOTE. The TLA60O series logic analyzers do not have replaceable hard disk
drives.
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Figure 1-17: Depress the hard disk drive latch
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Figure 1-18: Unlatching the hard disk drive cartridge
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Figure 1-19: Removing the hard disk drive cartridge
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Connecting Probes to the Target System

The logic analyzer connects to the target system through probes. The LA probes
allow you to connect to the target system in several different ways as shown in
the following illustrations. You can use the color-coded probe channels to map
the hardware connections to the channel settings in the LA Setup window. Each
LA probe group consists of eight channels that can be individually named in the
LA Setup menu.

NOTE. Power off the target system and the logic analyzer before connecting the
probes to the target system.

Connect the probes to the logic analyzer by matching the color-coded label to the
label on the LA module. Table 1-4 identifies the recommended probes for each
logic analyzer series.

Table 1-4: Probe/Logic Analyzer cross reference

TLA7Lx/Mx | TLA7Nx/Px/Qx | TLA600 TLA7Axx
General Purpose Probe | P6417/P6418 | P6417/P6418 P6417/P6418 | P6810
High Density Probe P6434 P6434 P6434 P6860!
High Density N/A N/A N/A P68802
Differential Probe

1 Differential clocks with single-ended data

2 Differential clocks with differential data

General Purpose  The P6417, P6418, and P6810 probes provide a means of connecting to the
Connections target system for most applications.

P6417 and P6418 17-Channel Probes. Figure 1-20 shows different ways to
connect the P6417 and P6418 probes to the target system. To provide a secure
connection to the LA module, you can optionally use the probe retainer bracket
with the probe connector.

Note the location of the ground connections for the probe:
®m  The individual podlets have the ground (GND) engraved on the podlet.

B When you use the 8-channel leadsets, the ground lead is a single black
connector. Make sure you connect the ground side of the 8-channel leadset to
the ground side of the 8-channel podlet holder.

Refer to the P6417 & P6418 Logic Analyzer Probe Instructions for information
on dimensions for the P6417 and P6418 probes.
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P6810 34-Channel Probe. The P6810 probe is a 34-channel, general purpose
logic analyzer probe that is used with the TLA7Axx Logic Analyzer series.
Figure 1-21 shows how to connect the probe to the target system.

Ground

Ground

Figure 1-20: Connecting the 17-channel general purpose probe to the target
system
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1-Connect 8 podlets in the podlet holder
directly to square pins on the PCB with
0.100 in pin spacing.

2-Connect 1 podlet directly to the square pins
on the PCB with 2 mm (0.039 in) or 2.54 mm
(0.100 in) pin spacing.

3-Connect 1 podlet with 1 channel leadset to the square pin on the PCB with 2 mm (0.039 in) or 2.54 mm
(0.100 in) pin spacing. The negative lead (half-white/half-black housing that contains a damping resistor) is
connected to ground in a single-ended application lead or the minus in a differential application.

4-Connect 8 podlets in the podlet holder with an 8 channel differential leadset to the square pins on the PCB
with 2 mm (0.039 in) or 2.54 mm (0.100 in) pin spacing. The negative lead (half-white/half-black housing that
contains a damping resistor) is connected to the minus in a differential application.

5-Connect 8 podlets in the podlet holder with an 8 channel single-ended leadset to the square pins on the
PCB with 2 mm (0.039 in) or 2.54 mm (0.100 in) pin spacing. The negative lead (total black housing that
contains no damping resistor; however, the leadset housing contains a damping resistor in ground path for
each channel) is connected to ground in a single-ended application lead.

Figure 1-21: Connecting the 34-channel P6810 general purpose probe to the target
system
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High-Density Probe  P6434 Mass Termination Probe. The P6434 Mass Termination Probe allows you
Connections  to connect 34 LA channels to a microprocessor probe adapter or directly to the
target system. To connect to the target system directly, you must include
compatible Mictor connectors in your circuit board design.

Figure 1-22 shows two ways of connecting the LA module to a target system.
For more instructions on this probe and instructions for connecting it to your
target system, refer to the P6434 Mass Termination Probe Instructions.

Low profile
connector

probe connection
Connector with
reduced bies connector
(optional)

Figure 1-22: P6434 High-Density Probe connections
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P6860 High-Density Probe. The P6860 probe is a 34-channel, high-density
compression probe consisting of two independent probe heads of 17 channel
connectors each (16 data and 1 clock/qual). This probe possesses differential
clock and single-ended data input capabilities.

P6880 High-Density Differential Probe. The P6880 probe is a 34-channel,
high-density differential compression probe consisting of four independent probe
heads of 8/9 channels each. This probe also possesses differential clock and
differential data input capabilities.

NOTE. Compression probes provide a compression contact, which eliminates the
need for a built-in connector.

Figure 1-23 shows how to connect the compression probes to the Logic
Analyzer and to the target system. For more information on the P6860 and

P6880 probes and adapters, refer to the P6810, P6860, and P6880 Logic
Analyzer Probes Instruction Manual.
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Thin black
(no rib)

Press-in nuts Nut Bar Mictor-on-PCB

Figure 1-23: P6860 High-Density Probe and P6880 Differential Probe connections

NOTE. When connecting the P6860 or P6880 probe head to the target system,
make sure that the alignment pin on the probe head is aligned with the hole on
the test fixture. Tighten the probe head screws by alternating between them until
they are finger tight (no more than 1 in-Ibs of torque).
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Microprocessor
Connections

DSO Probe Connections

Pattern Generator Probes

Additional Information

Online Help

All LA probes can be connected to microprocessor adapters. Refer to the
documentation that came with your microprocessor disassembler package for
details about connecting the probes to the microprocessor adapters and to the
target system.

Refer to the user documentation that came with your DSO probes (P6243 and
P6245 probes) for connecting and using the DSO probes.

Refer to the TLA7PG2 Pattern Generator Probe Instruction Manual for more
information on using the pattern generator probes with the pattern generator
module.

This section lists sources for more information. These sources are shipped with
your logic analyzer.

The online help gives detailed information about the logic analyzer and its
modules. Look in the online help for details about user interface selections that
are not described in this manual. The online help also has basic operating
information for microprocessor support products.

To access online help, go to the Help menu or click the toolbar buttons shown:

TLA - Waveform 1 == x|
File Edit “iew Data System Window Help

cel & B B 7] sws | Run I3 I

Click for Topic help.

Click for What's This? help on selected object.

Help topics tell you how to perform tasks and describe software features and
selections shown on the screen. There are two types of help topics: overview
topics and task topics.

Overview topics describe application features, such as the different application
windows. Overview topics also describe concepts. Overview topics are available
through the Help menu and through Help buttons in dialog boxes. From the Help
menu, click Help Topics and locate the topic using the Contents or Index tab.
The Help on Window selection in the Help menu provides overview help for the
currently selected window.
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Software

Task topics provide procedure information about how to perform specific tasks.
Task topics are available through the Help menu. From the Help menu, click
Help Topics and locate the topic using the Contents or Index tab.

What’s This? Help. What’s This? help provides a short description of the control
or screen feature selected. First click the What’s This? button on the toolbar, and
then click the item of interest. For further information about the item, go to the
Topic help.

TPI Online Help. Select Help on TPI from the drop-down help menu for
information on using the TLA Programmatic Interface. A printable version of the
TPI online help is available on the instrument. Click Start > Programs >
Tektronix Logic Analyzer > TLA Documentation > TPI Manual.

TLAScript Online Help. TLAScript is a script that works with TPI. Select Help
from the menu bar within the TLAScript application. To start TLAScript, select
Start > Programs > Tektronix Logic Analyzer > TLAScript.

Pattern Generator Online Help. Select Help on TLA7PG2 from the drop-down
help menu for information on using the TLA Pattern Generator.

PPI Online Help. Select Help on the TLA7PG2 PPI from the drop-down help
menu for information on using the TLA Pattern Generator. A printable version of
the PPI online help is available on the instrument. Click Start > Programs >
Tektronix Pattern Generator > Pattern Generator Documentation > PPI Manual.

To access the Logic Analyzer Release Notes, select Start > Programs > Tektronix
Logic Analyzer > TLA Release Notes.

Microsoft Windows Online Help. Information about Microsoft Windows features is
available through the Windows help system. Access Microsoft Windows help as
you would with any Microsoft Windows application.

PV Adjust Online Help. Available only on the TLA7Axx modules, online help is
available from the TLA7Axx PVAdjust program. To access the TLA7Axx
PVAdjust program select Start > Programs > Tektronix Logic Analyzer >
TLA7Axx PVAdjust. Click the Help button to access the online help.

TLAVu and PatGenVu software applications provide you with the ability to view
your TLA data offline on your own Microsoft Windows-based PC. Both TLAVu
and PatGenVu are versions of the TLA software and Pattern Generator Software
that contain online help content identical to the help provided in the respective
applications.
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Release Notes  The online Release Notes contain information about this release of the logic
analyzer application and pattern generator application. Check the Release Notes
for information such as software compatibility and software version differences
from earlier releases.

To access the Logic Analyzer Release Notes, click Start > Programs > Tektronix
Logic Analyzer > TLA Release Notes.

To access the Pattern Generator Release Notes, click Start > Programs >
Tektronix Pattern Generator > Pattern Generator Release Notes.
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Functional Overview

This chapter is divided into the following sections:

®  Functional Overview. Provides an overview of the front panel controls of the
logic analyzer and the location of external connectors.

B Approaching the Tektronix Logic Analyzer Windows. Provides a high-level
overview of the basic logic analyzer and DSO windows.

B Approaching the Pattern Generator Application Windows. Provides a
high-level overview of the basic pattern generator windows.

®  Operating Basics. Provides an overview of the logic analyzer operation.

Front Panel Controls

This section introduces you to the front panel controls of the TLA600 series
logic analyzer and the portable mainframe. It provides a brief overview on how
to use the front panel controls.

In addition to the front panel controls, you can also control the logic analyzer
from an attached keyboard and mouse.

TLA600 Front Panel
Controls

front panel. See Figure 2-1.

Horizontal —

+ Vertical

7

N
(@ VERTICAL HORIZONTAL ' )
-~ POSITICN POSITION
T O] -
A SEE SCALE

ez el
B9, <
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oo ooodgog
ooogooooooogLd
oo dgog
oo ooooogog

For the TLA61x and TLA62x you can use the front panel keys as an alternative
to an external keyboard. Most keys and key combinations are available using the

— General-Purpose
Knob

— Run/Stop

Qwerty
Keypad

\ J

Figure 2-1: TLA61x/62x Logic analyzer front panel
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Portable Mainframe Front

Panel Controls

For key combinations, it is not necessary to hold down more than one key at a
time. For example, you can press the SHIFT key in the hexadecimal keypad, and
then press a keypad key to accomplish a Shift+key combination. The same is
true for other key combinations, such as CTRL and ALT keys.

The portable mainframe has front-panel controls that operate the logic analyzer
without an external mouse or keyboard.

Changes the value in a selected Moves the display pointer
box (such as sample rate or \ Ve and selects objects. See
memory depth). With a cursor Q Trackball on page 2-3
selected, the knob controls cursor for more information.
position. Does not scroll data.
e Scrolls data horizontally.
(SN ] .
Scrolls data vertically. — i
oDao
oDao
CJ OCNNao
~—
Changes the height of %%%%%%%%%% . o
selected waveform gy e Changes Time/Div in
(Waveform window only). the Waveform window.

Figure 2-2: TLA715 Portable mainframe front panel

Keyboard. For the portable mainframe, you can use the front panel keys as an
alternative to an external keyboard. Most keys and key combinations are
available using the front panel.

For key combinations, it is not necessary to hold down more than one key at a
time. For example, you can press the SHIFT key in the hexadecimal keypad, and
then press a keypad key to accomplish a Shift+key combination. The same is
true for other key combinations, such as CTRL and ALT keys.

GlidePoint Pad. The TLA714 Portable Mainframe has a GlidePoint pad as an
alternative to the mouse. To move the pointer, slide your finger lightly over the
surface of the pad. Tap the surface to simulate a click of the left mouse button, or
use the control buttons to select the type of operation.

( JseLec]
(LEFT)

Figure 2- 3: GlidePoint pad
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Trackball. The TLA715 portable mainframe has a Trackball as an alternative to
the mouse. To move the pointer, roll the trackball in the direction that you want
the pointer to go. Press the Select button to simulate a click of the left mouse
button, or use the control buttons to select the type of operation. Press the Menu
button to simulate a click of the right mouse button.

MENU
(RIGHT)

Figure 2-4: Trackball

Tektronix Logic Analyzer Family User Manual, Version 4.2 Software 2-3



Functional Overview

TLAG600 Series External Connectors

The external connectors on the rear panel of the TLA600 series logic analyzer are
shown in Figure 2-5.

Description.......................... Icon/Label Locations

Monitor............... SVGA OUT @

El
Printer. LPT

RS-232..... COM 1
Network........ccceeeeeeecennnee. %
MOUSE.....eceeeeereeereceeieae %
Keyboard.............cccoccoen
USB o
Audi0 LN 1M =)
Audio Line Out.........cccoueeunece. ﬁ
CD DIiV8.e disce —l
\ 7R
O =3 L]
T U L \eCn
00280 B S A
00 —— R COM 1 - SVGADUT@
= 200 @©© - oo
[[Joo&y
I ®00 0 =
L C \_1 [ :
EXTERNAL SIG OUT
EXTERNAL SIG IN
SYSTEM TRIG OUT
SYSTEM TRIG IN
PC CARD
Card Slot........... TYPE2/TYPE3

Figure 2-5: TLA600 series external connectors
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TLAG600 Series Chassis Ground Connections

Figure 2-6 shows the chassis ground connection. Use the chassis ground
connections to connect the grounds of the target system (system-under-test) to
the logic analyzer to ensure a common ground connection between instruments.

ground screw from the logic analyzer. The safety ground screw must always be in

é WARNING. To reduce the risk of an electrical shock, do not remove the safety
place to ensure proper grounding of the power supply to the logic analyzer.

=== Q
= g A S
200300 L o e

nOHRE, |

o5t

[0

L) 5 (J

L] L]

Ground connection

Figure 2-6: Location of ground connection

TLA700 Series External Connectors

The mainframe external connectors are shown in Figure 2-7. The following
connections are available:

®m  System Trigger In and System Trigger Out, used to receive or send a trigger
from/to an external source.

®  External Signal In and External Signal Out, used to receive or send a signal
from/to an external source.

B Accessory connections.

Tektronix Logic Analyzer Family User Manual, Version 4.2 Software 2-5



Functional Overview

PC cards (2) PC cards (2)
SYSS\;ISEIAEQARTGRISJ: @ ‘ Secondary video SYSTEM TRIG IN——® @ SVGA OUT port
COM port —> [ ] ([l<—— Primary video SYSTEM TRIG OUT —>=© [}<— cOM port
= EXTERNALSIGIN—=® 7
EXTERNAL SIG IN H LPT printer port : H LPT printer port
EXTERNAL SIG OUT —=© U EXTERNAL SIG OUT —=© U
TLA715 Portable mainframe (rear view) TLAT14
a3l ©1 TDes
Indicator N i g
iD <—H — PC cards (2) Indicator g T PC cards (2)
Floppy drive E«— CD-ROM Disc Floppy drive ﬁ Il cp-Rom Disc
. 51 1l'| |- COM port !
Secondary video U E p SVGA OUT port H @o
Primary video F@@ W/ HARD DRIVE COM port < @ | | HARD DRIVE
MUSB ]| Jo<-—— SYSTEMTRIG IN USB — Il o< | SYSTEMTRIG IN
ouse Q (Ow ] SYSTEMTRIG OUT Mouse gw ™~ SYSTEMTRIG OUT
> v 9 >
Keyboard [ —bifio ™ [ EXTERNALSIGIN Keyboard -~ |_T(7s (\\ EXTERNALSIG IN
EXTERNAL SIG OUT |\ EXTERNALSIG OUT
[ \ \
LPT printer port LPT printer port
TLA721 Benchtop mainframe (front view) TLA720

Figure 2-7: TLA700 series external connectors

TLA700 Series Chassis Ground Connections

Figure 2-8 shows chassis ground connections. Use the chassis ground connec-
tions to connect the grounds of one or more instruments to the mainframe to
ensure a common ground connection between instruments.

ground screw from the benchtop mainframe. The safety ground screw must
always be in place to ensure proper grounding of the power supply to the
mainframe.

é WARNING. To reduce the risk of an electrical shock, do not remove the safety
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Chassis ground

ag—
= ——
— Do o0 ooo0oo0
= }—{‘ DDDDDDDDDDDDDDDDDD
5 |S— 000000000
° Safetyground DDDDDDDDDDDDDDDDDD
— (] U screw (Benchtop NI S = = R = i
e mainframe only) Conemeeen
D S n
- D o

|

Figure 2-8: Location of ground connections
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The Tektronix Logic Analyzer application interface consists of Setup and Data
windows as shown in Figure 2-9.

1 Go to the System window. This is the ]
main access point to the other windows. 2 Use the Setup windows

to configure the modules.
000 [oo0 —

— [ o m— Y S—
—

5 View data in the data E E

windows. J

3 From the LA Trigger window, load a
trigger program from the library and
customize it for your application.

|
—
———
—

4 Click the Run toolbar
button to acquire data. ‘/

Figure 2-9: Window usage control flow

System Window

The System window is your point-of-entry into the logic analyzer and functions
as the overall control center. The System window on a TLA600 series logic
analyzer (Figure 2-10) is almost identical to the System window on the TLA700
series logic analyzer (Figure 2-11). The only difference between the two System
windows is that the TLA700 series System window reflects the additional
modules available with the TLA700 series.
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B Svstem M=

Loaiz JFLITAT
Aralyzer

a0n ":,:'g;l _J"

QOff See:u‘ Trig

E—

17T
4131361123
A1 |5E[1123
A1[36/1183

|Li&ting 1 IWavefnrm 1

Figure 2-10: System window on a TLA600 series

B System [_[O] 4]
Mainframe Expansion 1 Expansion 2

gital Logic Logic Logic Logic
Osclllnscope Slots 3-4 Analyzer S\ms 5 B Analyzer Slﬂts 3 ] Analyzel Slots | '] Analyzer Slﬂts ? 12
OUn = °0n ,:.:. °0n ,:.:. °0n °0n ,:.:.

o

OUff Setu Tng QOff Setu Tﬂg O0Off Setu Tng O0ff Setu Tng O0Off Setu Tng
[psot JLan a2 JLas JLaa

MM Setup: LA 4 EIRIET IﬁTl er 144 -] [=] ES

mﬁelup LA1 EEE WTllggel LA 1 EEE mﬁelup LA 2 EEE Wﬁlggel LA 2 EEE |

For Help. press F1 [ | mxmonix 4

Figure 2-11: System window on a TLA700 series

You can perform the following functions from the System window:

B Open module and data windows by clicking their icons. To select a module
without opening its window, click inside the icon.

®  Create new data windows through the New Data Window wizard. You can
create Histogram windows for performance analysis operations and Source
windows to track the execution of source code. You can also create
additional Listing and Waveform windows.
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®  Use the System window for an overview of how the modules and data
windows relate to one another. Relationships between modules (if any) are
always shown; to view which modules are associated with a data window,
you must select the module icon.

B View which modules provide data to each window by clicking the window
name.

B FEnable and disable modules by clicking their On/Off buttons.

®  Save and load files containing setup, trigger, and data information using the
File menu.

®  Add an external oscilloscope connection or delete an existing external
oscilloscope connection using the context menu.

Setup Windows

Before you acquire and display data, you must first configure the modules using
the module Setup windows. Each module has its own Setup and Trigger
window; each module is set up individually. Configure the Setup window before
configuring the Trigger window because the Setup window settings affect the
Trigger window selections. An example of a logic analyzer Setup window is
shown in Figure 2-12.

0 TLA - [Setup: LA 1] [_[=1x]
El File Edit System Window Help —i®]]
EEE == R [ Run | JE |
Clocking: I\memal j |2ns j temaony Depth:  |67108864 2
Acguire Normal - Support Package: None
Analog Feads Suppress. Define Cormpare
Group Name MSB Probe Channels LSB =
ICKD (0-0p  |CKO
43 (70 A0
42 (70 | A2(7-0)
Probe Channels { Names
Probe 7 — — 4 3 2 1 o CLKQual
of w e =] =] 0 =] =] 0 =] oo =
o] 42 |o] [ = 0 [ = 0 [ x|
A | ] ] _ ] ] _ ] K
R = = L = = L = =]
| D3 = | | O | | O | Qo
| bz | = = L = = L = =]
| D1 = | | O | | O | Cl2
Do
C3 CK3
c2
C1 a1 &
xl In selected group
_| Mot grouped Table Shows: |Channel Polarity
LI In other groun(s) Channel Compare
FarHelp, press F1 Tekaronix

Figure 2-12: LA Setup window
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Trigger Windows
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LA Trigger Window

Use the DSO Setup window to define the channel and horizontal setups for the
DSO module. An example of a DSO Setup window is shown in Figure 2-13.

¥ Setup: DSO 1 M=l E3

Charinel 1 | Channel ZI Charnel 3| Charinel 4| Holizontall Tliggerl

Wertical |nput W oltage

Range: = S bl amimum B.5
[pk-pk wvaltz) 7] _Iﬁ \/\
Dffzet: I3V j =

------------------------ birirnur: -500r

Terminahon Autoset
I . - (Blutz
B andundth; IFuII l |7 - 50n & |

Coupling: IDE vl 140 Probe Cal... |
Signal Name: IEhanneH Probe Type:1x

Figure 2-13: DSO Setup window

Logic analyzer and DSO modules have their own Trigger windows. Use the
Trigger window to define the conditions when the instrument acquires and stores
data.

This version of the TLA600/700 logic analyzers simplifies triggers by providing
a list of trigger programs for you to either load or use as the basis for developing
customized trigger programs that are specifically designed to your data require-
ments. The EasyTrigger tab lists all available predefined trigger programs and
provides both a text description and graphical representation of each. The system
responds by displaying a simplified version of the program’s event conditions.
The PowerTrigger tab shows the general structure of the trigger program and
summarizes activity within individual program states.

You can also use the PowerTrigger tab to manually define simple or complex
trigger programs one step at a time to determine how the logic analyzer finds the
data you are interested in.

See Figure 2-14 for an example of the default LA Trigger window.
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DSO Trigger Window

!ﬁTrlgger: LA 1

=10l

Trigger Pos —— p—

Lot ot o A o O I T |

EasyTriggsr I PowerTrigger |

[=- Simple Events

Trigger immediately

‘Wait For systern trigger

Run urtil the Skop butkon is pressed
Trigaer on channel low/high (evel)

- Trig@er an channel transition {edge)

Trigger immediately.

Triggers on the first sample.

IAnything e l

Triggers on the very first sample imespective of
the event type. @
The Event field iz fixed to ‘Anything’ and
dizabled to ensure that tigger occurs on IS
the very first gample imespective of the
event lpe.

MR R A RK O

Start of
acouisition

X

Figure 2-14: LA Trigger window

The DSO Trigger window lets you define how to trigger the DSO on analog and

digital signals. See Figure 2-15.

I Setup: DSO 1 M= E
Charinel 1 I Channel 2 | Channel 3 I Charinel 4 I Horizontal  Trigger I
— Event T.'-’Dﬁfllmmediale j‘
Mode: | Mormal M
OS0 will Trigger I J
immediately after Actior: ITrigger j

it iz amned.

Trigger P ozition

D50 may be armed by the

Bun command or by anokkes

module in the Spstem.

Figure 2-15: DSO Trigger window
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Data Windows
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Listing Windows

Waveform Windows

You can use data windows to display and analyze acquired data from the logic
analyzer or DSO modules. The most common data windows are the Listing
windows and Waveform windows. These are the two default windows.

To display and evaluate complex logic analyzer data, you can create other types
of data windows using the New Data Window wizard (such as the Histogram
window and the Source window). For more information on the New Data
Window Wizard, refer to Creating a New Data Window beginning on page 3-90
or the online help.

You can have as many data windows as you want to display different data or
different views of the same data.

Listing windows display logic analyzer data in lists or columns. The following
list describes some of the tasks you can perform with Listing windows.

Place user marks to flag specific data samples for evaluation.

Use the scroll bars to move through the data or jump to a specific point in
the data by clicking the Go To toolbar button and selecting a mark.

Search for a data event by clicking the Define Search button in the toolbar.
Add columns by clicking the Add Column toolbar button.

Move columns by clicking on their labels to select them, and then dragging
them to a new location.

Split the window into two panes for viewing data that is off screen.
Click and drag columns.

Identity sample suppression.

Waveform windows display DSO or LA waveform data. The following list
describes some of the tasks you can perform with Waveform windows.

Perform automatic measurements on DSO analog waveforms.
Use the cursors to take time or voltage measurements.
Place user marks to flag specific data samples for evaluation.

Overlay waveforms.
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Identify sample suppression.
View collections of logic analyzer module waveforms as busforms.

View the value of a logic analyzer module waveform group versus time
using magnitude mode.

Expand and contract busforms.

Move waveforms by clicking their labels to select them and then dragging
them to a new location.

Split the window into two panes for viewing data that is off screen.

Use the scroll bars to move through the data or jump to a specific point in
the data by clicking the Go To toolbar button and selecting a mark.

Histogram Windows  Histogram windows display logic analyzer data as histograms. You use
Histogram windows to evaluate the performance of software, which is also
known as performance analysis. The following list describes some of the tasks
you can perform with Histogram windows.

Use the scroll bars to move through the data.
Sort histogram data by ranges, counts, or percentages.

Change the magnification of histogram bars to view the data in greater
detail.

Split the window into two panes for viewing data that is off screen.

View various statistics on the acquired data.

Source Windows  Source windows display source data. You can track the execution of source code,
based on the data displayed in a Listing window. The following list describes
some of the tasks you can perform with Source windows.

Step through source code statements.
Turn source code line numbers on or off.
Place user marks to flag specific data samples for evaluation.

Use the scroll bars to move through the data, or jump to a specific point in
the data by clicking the Go To toolbar button and selecting a mark.

Search for source code statements by clicking the Define Search button in
the toolbar.

Determine whether there is any acquired data for the corresponding source
file displayed in the Source window.
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MagniVu Data
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MagniVu data is the result of asynchronous digital oversampling acquisition.
This data is automatically acquired whenever you perform an acquisition. This
means that even if you specify synchronous acquisition, you can view the
asynchronous data at any time without having to reacquire. MagniVu functional-
ity is designed to acquire data at a high sample rate allowing you to see the
timing of signals in much greater detail. This is useful when you are debugging
hardware and needing higher resolution data samples for viewing events that
change very quickly.

The logic analyzer modules have MagniVu data acquisition as a standard feature.
MagniVu acquisition offers 500 ps high-resolution sampling rate on both
TLA600 and TLA7Lx/Mx/Nx/Px/Qx modules simultaneous with either

100 MHz or 200 MHz maximum synchronous speed on all channels through the
same probes. Both the MagniVu sample and storage rates are 2 GS/s. MagniVu
memory depth is set to a fixed 2K.

MagniVu acquisition for TLA7Axx modules offers 125 ps high-resolution
sampling rate with 120, 235, or 450 MHz maximum synchronous speed on all
channels through the same probes. The MagniVu sample rate is 8 GS/s; while the
MagniVu storage rate can be 8 GS/s, 4 GS/s, 2 GS/s or 1 GS/s. Setting a lower
storage rate allows you to stretch MagniVu memory over a greater span of time,
providing a lower resolution data sample from a greater time period. MagniVu
memory depth is set to a fixed 16K.

The example in Figure 2-16 shows regular data and MagniVu data for the same
channels. The MagniVu channels have the “Mag_" prefix associated with each
channel and with group names. You can add MagniVu data with the Add
Waveform toolbar button.
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Figure 2-16: Comparing regular and MagniVu data

Saving and Loading Setups and Data

Once you set up the logic analyzer to your satisfaction, you will probably want
to save the setup for future use. You can save setup information as a saved
system file or as a saved module file. You can also independently save LA
module trigger information.

Saved system files contain setup and trigger information for each module as well
as system level information (such as repetitive properties) and data windows for
the logic analyzer. Saved module files contain setup and trigger information for
only the specified module. In both cases, you have the option of saving acquired
data with the files. Saved LA module trigger files contain trigger state informa-
tion as well as information about the currently selected EasyTrigger program. If
you do not use an EasyTrigger program as the basis for your modified trigger
design, but instead use the PowerTrigger tab to develop your trigger program,
only a TLA file with the state information is saved.

Execute Save and Load operations from the File menu. For module Save or Load
operations, you must first go to the module Setup or Trigger window. Execute
the trigger save operation by clicking the Save Trigger button from the Trigger
window.
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Save the setups and data in a folder where you can easily retrieve them. For
example, you may want to save the data in the My Documents folder or within a
folder of your own choosing. You should not save the data in a location that may
be difficult to find or in a location (such as the Microsoft Windows System
folder) that may cause problems with your operating system.

Avoid using file name extensions other than the default extensions supplied by
the system. The logic analyzer may not recognize saved setups with nonstandard
file name extensions.

Saved system and module files both contain trigger program information. When
you load a trigger from the LA Trigger window, you can select a saved system or
module file as the source. When you do so, the logic analyzer extracts only the
trigger information from the file and loads it to the module.

Customizing the Display

You can customize your data windows. Using property sheets, you can control
data window display parameters. Many screen elements, such as waveforms,
columns, and marks, have their own property sheets. Figure 2-17 shows an
example of a typical property sheet.

Open data window property sheets by clicking the Properties toolbar button on
the data window. Open screen element property sheets by double-clicking the
element or its label.

Properties - Wavyeform 1 ﬂil

AboulData' w avetorm window W aveform | Marks |

Waweform: |l

Saurce: Curmert: DSO 1: Channel1 Height: IE;D 3:

Slotz 56
 Color
 Fined: -
* Fived: Il:l I IV Shaw \Wavefarm
 Same As: I LI
—Meas it R eadout

W Shaw Readouts

Readout Color I|:| - I

ak. | Cancel | Anply | 0 ptions... I Help |

I eazurernent Setup... I

Figure 2-17: Using a property sheet to customize the display
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Programmatic Control

In addition to controlling the logic analyzer from the user interface, you can use
the TLA Programmatic Interface (TPI) to control the logic analyzer from a
separate program running on the logic analyzer or on a remote host. Information
for using TPI is included as part of the TLA online help. A printable version
(PDF file) of the TPI online help is available on the instrument. Click Start >
Programs > Tektronix Logic Analyzer > TLA Documentation > TPI Manual.
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The TLA pattern generator application is similar to the logic analyzer applica-
tion. Typically you use the windows in the pattern generator application as

shown in Figure 2-18.

3 Use the Program window to generate the

1 Go to the System window. This is the main
Block, Sequence, Sub Sequence and Event

access point to the other windows.

Click the
Program button

o g | e

|

— 7
Press the @ From Block Page
Setup button
. 4 Use the Listing or Waveform window to
2 Use .the Setup window to generate the pattern data for each
configure the module block

—r—31 [—1
 m—

= ==

5 Click the Run toolbar button to
send the program to the hardware

6 a.Run the TLA software and click Run
on the toolbar to acquire the data

b. View the pattern generated in
Listing and Waveform windows

Figure 2-18: Window usage control flow
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System Window

The pattern generator System window (see Figure 2-19) graphically represents
the pattern generator configuration. The modules are placed in slot order by the
application. This window functions as the main application window and provides
a familiar starting point for Tektronix logic analyzer users.

TLA 700 - Pattern Generator [_ O] x|
Fie  Swstem Yiew Windos Help
ﬁl Hl %l Ell *-?l 7 Status I |dle Run
HH System !E[E
Pattern JFLITHE Pattern SR Patlzin LT
Generator  5-6 Generatyr  7-10 Generator 11 - 12
ein| 5F o eon| 5% o oon| 53 B
QIff| Setp| Prag ooff| Seup| Prog SOff| Setup| Prac
PE 1 PG 2 [PG 4
4] -l
Fo Help, pr=zsz F1 | Tekironi: -/

Figure 2-19: System window

You can perform the following tasks in the System window:
®  Enable and disable modules by clicking their On/Off buttons.

®  Open Setup and Pattern windows by clicking the module icons. To select a
module without opening its window, click inside the icon.

Save and load files containing setup and pattern information from the File
menu.

Setup Windows

Before you can generate data, you must first configure the modules using the
module Setup windows. Each pattern generator module has its own set of Setup
windows. Click the Setup icon to open the Module Setup window and then select
the individual setup windows from tabs at the top of the windows.
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Module Setup Tab  Use the Module Setup tab to set various parameters pertaining to the current
pattern generator module such as clocking and the run modes. Figure 2-20
shows an example of the Module Setup tab.
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— Extenal Event Mcde

Threshold - IEI'V' _|::‘ J ILEVE| 'lforAdvan-:e
Prolarity : INulludI "'l ILU\"“~'| j‘— tor Jump

Figure 2-20: Module Setup tab

Channel Setup tab  Click the Channel Setup tab to define the individual channel setups. The Channel
Setup tab is similar to the LA Setup window. It shows all of the probe and
channel groupings. You can edit the groups as necessary to fit the needs of your
application.

Probe Setuptab  Click the Probe Setup tab to specify probe details such as the output threshold
voltage and inhibit information. The Probe Setup window shows the detailed
settings of all probes connected to the pattern generator module.

Signal Setup tab  Click the Signal Setup tab to define the input and output signals. Use these
signals together with the Program window settings to control the pattern
generator program.

Program Window

Use the Program window to develop the pattern generator program. The Program
window provides access to the Block tab, Sequence tab, Subsequence tab, and
the Event tab. Use the Program windows to create the data vectors and the
pattern generator program flow.
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2-24

Block Tab

Sequence Tab

Subsequence Tab

Event Tab

Use the Block tab to create blocks of data vectors. The Block tab lets you view
all of the data blocks in a single window without having to view the individual
data vectors. You can assign meaningful names to each data block and then use
those data blocks in the Sequence tab to create the pattern generator program.

Use the pattern generator Listing and Waveform windows from the Block tab to

create the data vectors that you want to send to the target system. Figure 2-21
shows an example of the Block tab.

[ Tektronix Pattern Generator - [Program: PG 1] M= 3
File Edit System Miew ‘wWindow Help == %]
D"|H @I ] | k?l ?l Status | Idle Run

= 2 717 vlzle| 5 )

Block ISequencel Subsequancal Event I

EBlock List :

Block Ho Block Hame Block Size
1 Init
2 Fun 40

3 |

For Help, press F1 TeMronix |/

Figure 2-21: Block tab

Use the Sequence tab to provide a high-level view of the pattern generator
program. Use the data blocks that you created in the Block tab together with
subsequences, signals, and events to create the pattern generator program. Use

labels with each sequence to help control the flow of the pattern generator
program.

Use the Subsequence tab to create subsequences or macros that contain tasks that
you may not want visible as part of the high-level sequence flow. You may want
to create a subsequence that repeats a series of data blocks before returning

control to the main program. You can use meaningful names with each subse-
quence.

Use the Event tab to define how to use external signals with the pattern generator

program. You can logically AND and OR the probe event inputs to provide
program control.
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Listing Windows  Use the pattern generator Listing window to edit the vector data. You can open
multiple listing windows to easily move selected data from one block to another
by copying and pasting the vector data. You can define the radix to help you set
up the vector data. For example, Figure 2-22 shows UserGrp3 with binary data
as compared to the other user groups which show their data in Hexadecimal.
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Figure 2-22: Listing window
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Waveform Window

Use the Patten Generator Waveform window to edit the vector data. This method
may be useful when you want to see the timing relationship between the pattern
generator channels. Figure 2-23 shows an example of a Waveform window.
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Figure 2-23: Waveform window

PG Run Properties Dialog Box

2-26

The Pattern Generator (PG) Run Properties dialog box selections determine if the
logic analyzer Run button will start and stop the pattern generator (PG) modules.
Access the dialog box by clicking PG Run Properties from the System menu
under the TLA application See Figure 2-24.

PG Bun Properties E E3 |

[F Pattern Generatar it installed and enabled

Wwhen the TLA Runs: IStart PG after TLA j

[ {Stop PG when TLA stops

[ If repetitive run, restart at each itteration

| ok, I Cancel | Help |

Figure 2-24: Pattern Generator Run Properties dialog box
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Operating Basics

This section provides an overview of logic analyzer concepts and some of the
features of the Tektronix Logic Analyzer.

To acquire and display signals from the target system, the logic analyzer must
perform a complex series of actions. For the most part, these actions are
transparent. However, it can be helpful to understand how the logic analyzer
operates. This knowledge can influence how you approach a logic analysis
problem.

Sampling and Digitizing a Signal

Acquisition is the process of sampling the input signal, digitizing it to convert it
into digital data, and assembling it into a waveform record. The order and
method of accomplishing these functions is different between the LA and DSO
modules.

The LA module converts incoming data into ones and zeros using a comparator
with a user-selectable threshold voltage. If the incoming signal is above the
threshold voltage, it is converted to a one; if it is below the threshold voltage, it
is converted to a zero. After digitizing the data, the LA module samples it at
regular time intervals. The sampled and digitized points are stored in memory
along with corresponding timing information. (See Figure 2-25.)

11 1 1 1 1 1 1 Digitalvalues

Threshold voltagg — — { — — —}— ——f —— — — —
Input signal

00 0 0O 0 00O
Sample clock NN

Figure 2-25: Acquiring a digital signal (LA module)
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The DSO module samples the voltage level of the signal at regular intervals, and
then converts the sampled analog data into 8-bit digital values (see Figure 2-26).
The sampled and digitized points are stored in memory along with corresponding
timing information.

+6.0V -
+55V 450V Digital values
Analog signal
25V
%
ov oV ov
Sample clock 1 ] 1 1 ] 1 1 ]

Figure 2-26: Acquiring an analog signal (DSO module)

LA Module Block Diagram

The LA module is the key element of the instrument. Functionally, the LA mod-
ule can be divided into several blocks, as shown in Figure 2-27. Refer to the
figure as you read about the functional blocks.

Comparator
Data from —={ Probes Sampler Memory
target
system T T
Threshold Trigger
voltage

Clock
Internal (asynchronous) or
External (synchronous)

Figure 2-27: Block diagram of the LA module acquisition and storage

Clocking  Clocks control when data is sampled. The point at which you sample data has a
great deal to do with the type and quality of data you acquire. For the LA
module, there are two primary approaches to clocking, external (synchronous)
clocking and internal (asynchronous) clocking. Generally you use external
clocking for listing data and internal clocking for waveform data.
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External (Synchronous) Clocking. This clocking mode is called an external or
synchronous clock because the clock is external to the logic analyzer, and is
synchronized to the target system. External clocking is the best choice when you
are primarily interested in state aspects of the data.

The signal you chose as the external clock to the logic analyzer should be the
signal that controls the activity of the other signals you want to observe. For
example, to observe the output states of a counter chip, use the clock input to the
counter chip to act as the external clock source to the logic analyzer. With this
setup, each clock pulse to the counter chip can also be used to clock data from
the counter output lines into the logic analyzer. As another example, to record the
data being written to a latch, you could use the load signal to the latch as the
external clock source to the logic analyzer.

Internal (Asynchronous) Clocking. Much activity can occur in the target system
between system clock signals. Using the LA module’s internal (asynchronous)
clock, you can view all activity in the target system, not just the data available at
the target system clock signal.

Internal clocking is the best choice when you are primarily interested in the
timing aspects of the data. It is important to note, however, that the value of
internal clocking is not limited to displaying waveforms. If you want a detailed
picture of data activity both during and between state changes, use internal
clocking. For example, internal clocking allows you to acquire and display glitch
information in either the Waveform or Listing windows.

Acquiring Data  When you start an acquisition, the logic analyzer begins sampling data from the
probes. Then, each time a sample clock occurs, data is sampled. Sampled data is
sent to the trigger functional block and to the main memory.

Triggering and Storage  The trigger program looks at sampled data for specific events and then takes a
Qualification  specified action. The trigger program can look for events such as data values,
data ranges, or signals from another module. You can also use internal counters
to trigger when the counter reaches a specified value.

When the trigger condition is satisfied, the LA module enables a post trigger
delay counter to allow the post trigger portion of the acquisition memory to fill
before stopping acquisition. You can also indicate a prefill portion of acquisition
memory that must be met before the trigger state machine can store post trigger
data.

The trigger function block includes storage qualification that looks at sampled
data. If the storage conditions are met, a storage qualifier signal enables sampled
data to pass into the acquisition memory as qualified data. Any unqualified data
samples are excluded.
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Storing Data in Memory  The acquisition memory works like a circular buffer, storing every qualified data
sample until the entire memory is full. After that, each new data sample
overwrites the oldest existing sample. This process continues until the trigger
event is found and the post trigger delay counter reaches the specified value
(based on the trigger position selection), which stops acquisition. During
acquisition, you can monitor the progress of the data storage process using the
Status Monitor.

After storing the data you can display the acquired data in the Listing or
Waveform data windows.

DSO Module Block Diagram

The DSO module adds analog analysis capability to the instrument. Functionally,
the DSO module can be divided into several blocks, as shown in Figure 2-28.
Refer to the figure as you read about the functional blocks.

System clock

L

Data from Probes Attenuators/ Acquisjtion Memory
target preamp unit
system T
Trigger

Figure 2-28: Block diagram of the DSO module acquisition and storage

Probes A probe interface detects the attenuation factor of each probe. This information is
used to set the vertical scale.

Acquiring Data  When you start an acquisition, the DSO module begins sampling data from the
probes. Each time a sample clock occurs, data is sampled. Signals from the
probes go to the attenuators/preamp functional block, which is responsible for
input coupling, termination, bandwidth, offset, and full scale range. The DSO
module always uses internal clocking.

From the attenuators/preamp, signals are sent to the acquisition unit and trigger
functional blocks.

Acquisition Unit  The acquisition unit functional block samples the input signals and converts
them to digital data.

2-30 Tektronix Logic Analyzer Family User Manual, Version 4.2 Software



Operating Basics

Triggering  The DSO trigger looks at sampled data for a specific event. The trigger can look
for various types of events, such as glitches, setup and hold violations, runt
pulses, or signals from another module.

When the trigger event is found, the DSO module enables its post trigger delay
counter to allow the post trigger portion of the acquisition memory to fill before
stopping acquisition. When triggered, the DSO module performs its specified
trigger action (for example, triggering all modules).

Storing Data in Memory  The acquisition memory works like a circular buffer, storing data samples until
the entire memory is full. After that, each new data sample overwrites the oldest
existing sample. This process continues until the trigger occurs and the post
trigger delay counter reaches the specified value (based on the trigger position
selection), which stops acquisition. During acquisition, you can monitor the
progress of the data storage process using the Status Monitor.

After storing the data you can display the acquired data in the data windows. In
the Waveform window, the data is shown as analog waveforms. In the Listing
window, the data is shown as a series of voltage values.

Pattern Generator Module Block Diagram

The pattern generator module adds pattern generator capability to the logic
analyzer. You can generate specific data patterns to a target system and then use
the logic analyzer to evaluate the resultant data from the target system.

The pattern generator module functionality can be divided into blocks as shown
in Figure 2-29. Refer to the figure as you read about the functional blocks.

System clock

Event &
Inhibit Data Probes = Program Probes |—> Data o target
T system
External
Clock

Figure 2-29: Block diagram of the pattern generator module
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Probes

Pattern Generator
Program

The probe interface serves two purposes: to detect event and inhibit information
and to output data to a target system. In addition to sending pattern generator
data to the target system, the probe also sends clock and strobe information.

You can connect up to four probes to a single module. Each probe supports either
8 or 16 channels.

The pattern generator program is the heart of the pattern generator module. You
can create blocks of data vectors to work together to create complex pattern
generator programs. The program uses external and internal events to determine
specific actions such as loops and branches to other data blocks. The program
can be controlled by an internally selected clock or by an external clock through
a front-panel BNC connector.

Use the Sequence Definition page of the Program window to set up and define a
sequence events that make up the pattern generator program. Each sequence line
determines how the pattern generator will use blocks of data that you define in
the Pattern Generator Listing or Waveform window. You can set up the program
to wait for specific events or signals and then jump to a different sequence when
an event is either true or false.

You can also set up the pattern generator to single step through programs and
output a single set of vectors with each clock cycle. This is useful for trouble-
shooting or debugging setups.
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Logic Analyzer Physical Model

Physically, the logic analyzer is made up of two main parts: the modules and the
mainframe. Figure 2-30 illustrates the relationship between the logic analyzer
and its subparts.

Logic Analyzer

Mainframe

Mechanical housing Disk drives

Display Power supply

Communications bus User interface software

Controller Low-level software
Module 1 Module 2 Module n
Module Module Module
Probes Probes Probes
Firmware Firmware Firmware

Figure 2- 30: Logic analyzer physical model

Logic Analyzer Conceptual Model

Conceptually, the logic analyzer is made up of two main parts: the modules and
the system. From the operational perspective, a module encompasses the setup,
trigger, and data associated with the physical logic analyzer, DSO module
installed in the logic analyzer, or the external oscilloscope that is physically
connected to the logic analyzer. See Figure 2-31. The system refers to the setup
and data for the whole logic analyzer, including all the modules.

Some actions occur at the module level, some at the system level. For example,
you can save either module or system files. When you save a module, you save
all the setup and trigger information for that module. (You also have the option
of saving the data for that module.) When you save a system, you save all the
setup information for the system, including data window display settings, and all
the module information, as well.
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System

Data Windows

General Settings
Module 1 Module 2 Module n
Setup Setup Setup
Trigger Trigger Trigger
Data Data Data

Figure 2-31: Logic analyzer conceptual model

Intermodule Interactions and Time Correlation

2-34

Each module has its own setup, trigger, and clocking functions. (LA modules
may include microprocessor support as part of their setup.) Each module also
acquires and stores its own data.

When you start an acquisition, all modules start acquiring data together.
(Exceptions are when one module has been programmed to arm another or when
a module has been turned off.) Modules stop acquiring data individually,
according to their trigger programming. You also have the option of setting the
logic analyzer to operate in repetitive mode, in which the modules acquire data
and update the data windows continually until you manually stop the acquisition.

Modules readily communicate with one another by means of their trigger
programs. You can specify functions such as the following:

®m  Trigger all modules (system trigger)
®  One module arms another
B Modules respond to events declared by another module (internal signals)

After the modules have captured and stored data, you can view the data in a
Listing or Waveform window. All data is time-correlated in the display,
regardless of its source. Due to the precise time stamp information stored with
the data, and the tightly-integrated communications between modules, the logic
analyzer interleaves data acquired from various sources. Because time stamp
information is always stored with the data, you can also compare saved data and
current data with no loss of accuracy.

MagniVu data is also time-correlated with regular data. Because MagniVu data is
always present, you can easily compare a normal acquisition with the MagniVu
counterpart.
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Listing-Data Concepts

In many cases, you will use the logic analyzer to observe the data flow in the
target system. The data recorded by the logic analyzer can be displayed in a
listing format, as shown in Figure 2-32.

Listing data is a table of sequential operations performed by the target system. In
the Listing window, each data sample is displayed sequentially. Because each
data sample includes time stamp information, it is a straightforward process to
display acquisitions from multiple data sources. Samples from all specified data
sources are interleaved in chronological order. For clarity, each line in the table
represents a single data sample from a single data source.

You control the presentation of the data by selecting the display radix of the
columns. You can also make other format selections such as font size, color, and
column width.
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Figure 2- 32: Listing data

You can include data acquired by the DSO module in the Listing window. The
Listing window in Figure 2-33 shows DSO module Channel 1 data as discrete
voltage levels. As with any module, the data samples from the DSO module are
time-correlated with the other data and appear on separate lines.
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Figure 2- 33: Listing window with analog data

Microprocessor Support

For microprocessor applications, the acquired data can be disassembled back into
the assembly language mnemonics used by a particular microprocessor.
Figure 2-34 shows an example of the disassembled mnemonic display format.
Microprocessor support usually requires a special input probe dedicated to a

specific microprocessor.

@Inlﬁwcnde
o] % B=(2] e Al 48] ¥] &

Ci: = ca Aoy Iﬁ'
My E8340 a3 — My B340 116 Dralea Tirme: |3.625us 5
— —
CEIM:E CRITEZ
Sample |‘ Addre=cs ||Data
£ 0 liielip Bl nooa { READ 1 5] -3 523,000 w
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2 Q0E0 3220 4250 T3T.L DAa (31 236 404,000 w
4 o0E03IEE 6EEE EGT.EF 00604212 (31 —26.027,.000 w
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Figure 2- 34: Listing data using a microprocessor support package
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The logic analyzer provides support for a wide variety of different microproces-
sors. Microprocessor support packages include the software, probe adapters, and
documentation.

High-Level Language (Source Code) Support

You can correlate the high-level language (HLL) source code that you wrote with
your code as it was executed on your target system and acquired by the logic
analyzer. The correlation is based on symbolic information that is extracted from
your object file or load module. You configure the logic analyzer to access your
source files.

You can step through each executed source statement in the Source window and
view the results in a correlated Listing window. You can also set user-defined
marks as break points within the code and then trace the execution of the code
between the marks. Figure 2-35 shows an example of viewing source code in a
Source window, while Figure 2-36 on page 2-38 shows the actual acquired data
in an associated Listing window.

[E Q-Driver _ O} |
EI Qﬂllﬂl g?ﬁ.ll AlAl }Iﬂﬁl"l ScanListing:ILater Y|

C1- |2E9 : CE:Iﬂ '__'l'__‘llmilil

Line | C:WProgram Files\TL& 700% Fampl eshTLATO0 SampleshSource Windowhdriver.c

TEY zh = imehl]; ;l
33:] if [ch == 0x04)
Ak =52 <h = Oxba;
[l Z70 fpucclch, stdin);
e § ceturn [chl;
ETE ¥
72
zn4a
B

ETe * DescriptFion: g+vs - get & rmll-teominatred characrsr string. Inpat
ETT * is terminased by a4 carriage Teturn.

z75 * Reatuins:

g
20| ink

281| |get=| char *buf)

zee| |1
za3 int n; 1
ot 1 char ch; —I
EEE no=0; LI

Figure 2- 35: High-level source code
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Figure 2-36: Source code viewed as acquired data

The LA module supports a wide variety of object files including IEEE695,
OMF51 OMF86, OMF286, OMF386, OMF166, COFF, Elf/Dwarfl and Dwarf2,
Elf/Stabs, and the TLA Symbol File (TSF) format (a text format). Refer to
Appendix B: TLA Symbol File Format.
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Waveform Data Concepts

You can use the logic analyzer to observe the timing relationships between
signals by displaying the recorded signal activity as a series of waveforms in the
Waveform window. Figure 2-37 shows waveform data from an LA module.

@Wavefﬂrm 1 |- (O] | I
(8. &= + 0] [livesmiv: [ins 7] |y

C1:-G0ns s e ETE = DekaTime: [100ns = I LockDeta Time

DSO 1: Channell  C1: cz Delta:

JSTART: Mag Sample
1START: Mag_Address | |IE
QSTART: Mag_Data
QSTART: Mag_Control
START: Mag_DataSize
O5TART: Mag_Misc
Q5TART: Sample O nz
GSTART. Addess | SO Y
OSTART: Data
OSTART: Control
O5START: DataSize
QSTART: Misc
Kl
&

Figure 2-37: Waveform data

Each waveform is initially displayed in a separate track, but all waveforms are
time-aligned horizontally and displayed in the same time per division. Again, the
inclusion of time stamp information with the stored data samples makes it a
straightforward process to display time-correlated acquisitions from multiple
data sources.

You control the horizontal scale of the acquired data in the display. (You do not,
however, change setup parameters by changing settings in the waveform
display.) You can also make other format selections such as channel group radix,
waveform color, and track height. To show when the logic analyzer sampled the
data, you can add Sample using the Add Waveform tool bar button.

When viewing logic analyzer data, you can view the data as individual channels.
You can also display the logic analyzer data in groups of channels known as
busforms. Use the busforms to display when data changes with respect to clock
or control signals. Another method of displaying logic analyzer data is to overlay
waveform channels. Use overlay waveforms to visually compare two or more
waveforms at the same time.
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LA Module Versus DSO

2-40

Waveforms

Sampling Resolution

When you are interested in displaying the value of a group of channels over a
period of time, you can use magnitude mode. For example, using magnitude
mode, you can view the channels connected to a 16-bit digital counter. The
magnitude waveform appears as a sawtooth waveform as the counter values
increment from the minimum value (00) to the maximum value (FF).

A logic analyzer waveform appears to have zero-length rise and fall times. This
is because the logic analyzer is recreating the waveform from the samples stored
in its memory, which are either ones or zeros.

No electronic signal is perfectly digital in nature; there is always some analog
component. Consider a fast-rising pulse with ringing on the front edge, or
glitches that can occur in a noisy circuit. If you suspect problems caused by
analog signal characteristics (such as signal voltages higher or lower than
specified voltage levels, or slow transition times), use a DSO module to observe
the voltage characteristics of the signal. Figure 2-38 shows where the DSO
module captured a runt pulse that was below the logic analyzer’s threshold.

Elfranayss @
(6] 5[] 5] FIS] <[t|wfmeov o =1 B[
C1: |4.887ns = cz |28 = DehaTime: [2ns =
My DS0: FF_G-0UT  C1: 416.1my C2: 1.408Y Deltar 391.9riv

JAnalgzer: Samele sl

) Analzzer: FF-CLE.

Mz Analzzer: FF-D
My dnalyzer: FF-0

Figure 2- 38: Using the DSO module to capture a runt pulse

The accuracy of the waveform re-created from the sampled data depends on the
sample clock rate used to record the incoming signals. This is due to the fact that
the waveform re-created by the logic analyzer is based on the sampled signals
stored in its memory. If the sample clock rate is too slow, the recorded data will
produce an inaccurate display. Figure 2-39 shows how the sample clock rate can
affect an LA waveform.

Insufficient DSO module sampling resolution can result in aliasing. For
information about aliasing, see page 2-42.
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Example 1: Slow sample clock
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Figure 2-39: LA module sampling resolution

Signal Resolution and  There is an important trade-off between the resolution of the recorded signal and
Signal Duration  its duration in terms of elapsed time. Because the total number of samples that

can be recorded by the logic analyzer is fixed by the depth of the logic analyzer’s
acquisition memory, increasing the sample clock rate provides better signal
resolution at the expense of reducing the duration of the captured signal. That is,
a faster sample clock rate will record a smaller portion of the signal, but with
better resolution; or, you can trade channels or depth to maintain higher
resolution.

It is important to remember that you have two additional tools for the TLA7Lx/
Mx/Nx/Px/Qx modules and three additional tools for the TLA7Axx modules to
offset the signal resolution/signal duration relationship:

® By using the MagniVu data feature available for all modules, you can view
high-resolution data centered about the LA module trigger. This allows you
to zoom in on the data of particular interest while still maintaining visibility
of a more extended signal duration.

® By using Internal 2X Clocking mode available for all modules, you can trade
one half the channels for twice the resolution and twice the memory depth.
The 2X Clocking mode is only available with the main timing (not with the
MagniVu data feature).

® By using Internal 4X Clocking mode available only for TLA7Axx modules,
you can trade three-quarters of the channels for four times the speed and
memory depth. The 4X Clocking mode is only available with the main
timing (not with the MagniVu data feature).
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Preventing Aliasing

Displaying Waveforms

High-Speed Timing

Under certain conditions, an analog waveform can be aliased on screen. When a
waveform aliases, it appears on screen with a frequency lower than the actual
waveform being input or it appears unstable. Aliasing occurs because the
instrument cannot sample the signal fast enough to construct an accurate
waveform record. (See Figure 2-40.)

Actual high-frequency ————
waveform

Apparent low-frequency ———
waveform due to aliasing

Sampled points ———

Figure 2-40: Aliasing

To check for aliasing, increase the sampling rate (decrease the clock sample
period) in the module Setup window. If the shape of the displayed waveform
changes drastically or becomes stable at a faster clock sample period setting,
your waveform was probably aliased.

Although the principles of sampling theory define a minimum sample rate of 2X,
a good rule of thumb is to choose a sample clock rate five times faster than the
speed of the fastest signal being measured. A faster sample clock rate results in a
more accurate reconstructed waveform.

Waveforms are rarely displayed at an exact one sample point per pixel. Wave-
forms are usually displayed in a compressed or expanded format. As a general
rule, waveforms are compressed when the time per pixel is greater than the time
per sample clock. Waveforms are expanded when the time per pixel is less than
the time per sample clock.

For compressed DSO waveforms, the display shows the lowest and highest point
that occupy a given pixel column joined by a vertical line. For expanded
waveforms, the display points between the actual sample points are calculated.

For expanded DSO waveforms, Sin(x)/x interpolation computes the display
points between the actual values acquired.

The LA module provides high-speed timing support through MagniVu data. The
MagniVu data is stored in a separate memory that is parallel to the main
memory. All data from the sampler goes directly to the MagniVu memory. The
MagniVu memory also works like a circular buffer. Unlike the acquisition
memory, the MagniVu memory does not qualify data storage through the trigger
function block.
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MagniVu data is continuously acquired on all channels at the fastest sample rate
of 500 ps for TLA7Lx/Mx/Nx/Px/Qx modules and 125 ps for TLA7Axx
modules. Like normal acquisition data, MagniVu data can be displayed in the
Listing or Waveform data windows. For TLA7Lx/Mx/Nx/Px/Qx modules, the
MagniVu data is centered on the LA module trigger in the data window. For
TLA7Axx modules, the trigger position for MagniVu data is variable; you
control the MagniVu trigger position by a set of controls in the advanced toolbar.
See MagniVu Data on page 3-106 for additional information.

Detecting Violations  One of the logic analyzer’s most useful features is its ability to detect and trigger
on both signal glitches and setup and hold violations.

A glitch is a signal that makes a transition through the threshold voltage two or
more times between successive acquisition samples. Because glitches are often
signal transitions that occur intermittently, they can cause circuit malfunctions
that are extremely difficult to diagnose.

Although you could try using a very fast sample clock rate to ensure that you
never miss any glitches, a better solution is to use the glitch-detection feature.
The logic analyzer can trigger on a glitch, either alone or in combination with
other signal events. This capability is useful for catching intermittent glitches
that might not occur very often or appear only when a particular operation is
taking place.

You can capture noise spikes and pulse ringing using the glitch capture feature.
Figures 2-41 and 2-42 show data captured by triggering on a glitch. In the
Waveform window, a glitch captured by an LA module is indicated by a band of
color. (See Figure 2-41. For clarity, an arrow identifies the glitch in the figure.)

A setup and hold violation is a data signal that transitions within the setup and
hold time period. You can identify setup and hold violations by looking at each
clock edge and reviewing all relevant data signals. However, it is more efficient
and reliable to use Setup/Hold triggering to identify violations.

You must select the correct clocking mode to use either the glitch detection or
the setup and hold violation features. Choose internal clocking to use glitch
detection; choose external clocking, source synchronous clocking, or custom
clocking to use setup and hold detection. For information on glitch storage, see
Selecting the Acquisition Mode on page 3-17.
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Figure 2-41: LA module triggering on a glitch
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Figure 2-42: DSO module triggering on a glitch
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Performance Analysis Concepts

For performance analysis applications, you can use the Histogram window to
view the performance of your software. The actual data is displayed as horizontal
bars in a histogram.

You may want to use the Histogram window to see which one of your software
routines is taking up most of the CPU time. Or, you can use the Histogram
window to measure the amount of time used by a particular subroutine. You can
use a symbol file to view each of the routines by name.

Figure 2-43 shows an example of the Histogram window where the StopLite
routine is taking up most of the computer resources.
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Figure 2-43: Viewing the performance of code with a Histogram window
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Comparing Acquired Data Against Saved Data

2-46

You can use the LA module to compare acquired data against saved reference
data. Use the LA Setup menu to define the data channels that you want to use
during the compare operations. You can further define the number of samples
that you want to compare as well as data alignment offset.

In the Listing and Waveform windows, you can use color to quickly identify the
compared data. You can set up one color to show where the acquired data does
not equal the reference data. You can use another color to show where the
acquired data equals the reference data.

Figure 2-44 shows a Listing window during a memory compare operation.
Notice that some of the data under the LA 2 A2 column appears in a different
color, indicating that there were differences between the acquired data and the
reference data.
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Figure 2-44: Using color to show memory differences in a Listing window
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Repetitive Acquisitions

Use the Repetitive acquisition features of the logic analyzer to automate
repetitive and time-consuming tasks. For example, you can specify the number
of times that you want the logic analyzer to acquire data. With each acquisition,
you can save the data to a file for analysis. You can also set up the logic analyzer
to open a file or execute a program when all of the acquisitions have been
completed.

You can set up the LA module to acquire and compare the acquisition data to
known reference data. The LA module can continue acquiring data until there is
a mismatch between the acquisition data and the reference data.

Figure 2-45 shows an example of such a setup where the acquired data is
exported to a file for each acquisition. When a data-mismatch occurs the logic
analyzer stops acquiring data and exports the data to a file. The faulty data can
now be analyzed by another application.

Repetitive Properhies BE
— &fter Each Acquisition

IV Save —IE:-cportData j—l’rom ﬂLED Errar j

Ta File: ILED Fault ek Browze. . |

& Save in zame file each acquisition.
" Save in new filz each acousition.  Starting file Suffis: |1

[ Stop if Compare with Reference iz INDI Equal "| on QSTART
[ Stop After |1 Acguizitions

—'when Stopped
I~ iOpen:

Open... |
Ok I Carcel | Help |

Figure 2-45: Defining repetitive setups
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Symbol Support

2-48

Symbols simplify tasks, such as setting up triggers or identifying specific values
within the data. When you program a trigger or view data, it is cambersome to
remember which numeric channel group values correspond to particular machine
instructions or code modules. The logic analyzer makes this task more manage-
able by allowing you to assign symbolic names or mnemonics to group values.

For example, assign the symbol WRITE to the control bus event that causes the
target system to write to a memory location. Then, if you want to trigger when a
write cycle occurs, enter WRITE in the trigger program in place of the actual
data value. You can also choose to have WRITE appear in the Listing window
for quick identification of the instruction.

In Figure 2-46, the example shows a trigger program that uses the symbol
BUS_ERROR as part of the trigger clause.

T Trigger: QSTART : =0l
D'J'll"jls'jl g}"mlmc'.ﬁl & | | EI Storage IAII 'l Trigger Pos —— j—
m Stake 1 |If Event A, Incremant Counker 1. =

Fun

fl Group Address =BUS_ERROR
Then| GoToZ

State 2
State 2 |

Channel ALT_EUS_D = High

Than | Trnane Al kdadilan

Figure 2-46: Using symbols in a trigger program

You can use symbol files with a Source window and an associated Listing
window to track the execution of source code. The symbol file provides the
information to associate a line of source code to an address in a Listing window.
When you move a cursor in one window, the symbol file provides the necessary
information to move the cursor to the correct location in the other window.

Often, the application software will define symbols for you. For example, when
you load a microprocessor support package, symbols are also loaded (typically,
to the control group). These symbols represent data values that correspond to bus
cycle types. Other software applications produce range symbol files which you
can load (typically, these files are loaded to the address group).
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Symbol Files

To use symbols, you must first load or create one or more symbol files that
define the symbols. Symbol files contain symbol names and their associated data
values. You can use symbol files created by another application, edit symbol files
from other applications, or you can create your own symbol files using a text
editor.

Each entry in a symbol file consists of an alphanumeric symbol name with its
associated numeric value or range of values. After you create a symbol file, you
can specify the symbol file for the appropriate channel group in the Waveform or
Listing window, use symbolic names as a substitute for numeric values in the
Trigger and data windows, and use symbols for tracing source code in a Source
window.

Symbol files perform like look-up tables. For example, if the address of a printer
I/O port is at address F734BC, you can define a symbol, printer-port, that
corresponds to that value. Then, in the Trigger window, you can specify the
symbol name as an event in the trigger program and cause the module to trigger
when printer-port (F734BC) appears on the address bus. You can also specify the
symbolic display radix for the address channel group and the symbol name
printer-port will show in the Listing window every time F734BC appears on the
address bus.

Symbol Types. Two main types of symbol files are possible: pattern symbol files
and range symbol files. Range symbols can be further divided into three different
categories: functions, variables, and source code (source). Table 2-1 shows the
different types of symbols and the windows where they are commonly used.

Table 2-1: Using symbols in logic analyzer windows

Range symbols
Window Pattern symbols Functions Variables Source code
Listing Yes Yes Yes Yes
Waveform Yes Yes Yes Yes
Histogram No Yes Yes No
Source No No No Yes
LA Trigger Yes Yes Yes Yes

Pattern Symbols. Pattern symbols consist of data patterns up to 32 bits. Each bit
in a pattern symbol can be 0, 1, or X (don’t care). Pattern symbols are used when
a group of signals define a logical state. For example, a microprocessor has a set
of pins that indicates the type of bus cycle in progress. A memory read cycle is
indicated when the RD~ and MREQ~ pins are 0 (logic low) and the BUSAK~
and M1~ pins are 1 (logic high). You can define a pattern symbol name called
mem-read that corresponds to bit pattern 1100 and thereby mark all memory read

Tektronix Logic Analyzer Family User Manual, Version 4.2 Software 2-49



Operating Basics

2-50

bus cycles in the Listing window. For other bus cycles the logic state of these
pins is also important and you can define different bit patterns for each cycle

type.

Figure 2-47 shows pattern symbols used in a Waveform window.

W’ave[olm 3 =] 3
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Figure 2-47: Waveforms using pattern symbols

Range Symbols. Range symbols define a range of 32-bit addresses represented by
a contiguous set of integers, marked by specific lower and upper bounds. The
different types of range symbols are discussed in detail under 7LA Symbol File
Format beginning on page B-1.

When defining a range symbol file, do not overlap ranges of values. If ranges
overlap, they may not be recognized. For example, it SYM1 covers the range
1000-3FFF, and SYM2 covers 2000-2FFF, then the values in range 2000-2FFF
may be recognized as either SYM1 or SYM2, and the values in the range
3000-3FFF may not be recognized as SYM1 at all.

The range symbols shown in Figure 2-48 define subroutine boundaries.

B Listing 1 [_ ol =]
|| & [B|@)] x| A Al 4% +] 7

C1: I 3 Cz: lﬁA
My 63340 1944 My 63340 1944 =
A& | Data || Control _I

17587 | CAFTURE DATA +3588 4EDO | GFCE
17586 | CAPTURE DATA +3584 41Fd | GFC7
1759 | CAFTURE DATA +41C8 Z05F | 8FC3
1790 | CAPTURE DATA +41CAh S08F | 6FCY
1791 | FORMATTEER +138 00s0 | AFCF
1792 | FORMATTER +134 8674 | AFCF
1793 | CAFTURE DATA +41CC 4EDO | GFC
1794 | CAFTURE DATA +41CE ZF07 | GFC7
1795 | DISPLAY EUF +674 EOS6 | 8FC3

[« [

L

T

Figure 2-48: Listing data using range symbols
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Symbols Dialog Box  Use the Symbols dialog box to provide an overview of all currently loaded

symbol files (see Figure 2-49). You can display information about all symbol
files currently used by the logic analyzer.

The following status information is available for each currently loaded symbol
file:

S5 ymhbols HE I

i~ Loaded Spmbiol File: |8 =l ==

The last time the file was loaded into the logic analyzer application software.
It also includes error and warning messages associated with the last load.

When the file was last modified. The logic analyzer also displays a message
if the file may need to be reloaded (such as when the file is modified after it
was first loaded).

The format of the loaded file.

If the file can be unloaded or if the file is currently in use. Symbol files can

only be unloaded if no data windows or setups are using them.

— Statusg

Last Loaded:
File Modified:
Format Loaded:

Can Be Unloaded:

06/23/38 01:50:02 PM
04/13/35 10:47:18 AM
TSF

Mo -File iz in use by a setup or data window.

— Content
Symbal Type:
Total Symbols:
Total Source Files:
Range:

Functions, YYarables, Source Cods
324
]

0RE03204 to 0x20000002 with offzet
O=E03204 o 0420000003 without offset

Help

Load... | [Hlaad E=part...

Figure 2-49: Symbols dialog box
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The following information is displayed in the Symbols dialog box:

®  Whether the file is a pattern symbol file or a range symbol file. If the file is a
range file, this field also lists the types of symbols loaded.

®  The number of symbols loaded from the file. Symbol files can have an
unlimited number of symbols. The number of symbols is limited by the
amount of memory. When you load a symbol file, the symbols are placed in
memory. Because symbol files consume memory, you should unload unused
symbol files to keep memory available for your main application.

B The number of source files referenced by source code symbols loaded from
the file.

B The minimum and maximum address values and offset information.

Click the Load button (see Figure 2-49) to open the Select Symbol File dialog
box and load a new symbol file. You can browse the file system for the symbol
file. If the symbol file is a range file, you can click the Options button in the
Select Symbol File dialog box to open the Load Symbols Options dialog box.

Click the Export button to save the current file as a TSF-format symbol file. You
can view the exported symbol file with applications such as Wordpad. Edit the
symbol file by saving it under a new name and using a text editor. Save the
edited file in text format. You can then load the edited symbol file.

Load Symbol Options  Use the Load Symbols Options dialog box (see Figure 2-50) to specify options
Dialog Box  for range symbol files before loading them into the system.

Load Symbols Options 2=

File Format: j

— aymbol Type:
[¥ Functions ¥ Vaiables [ SowceCode W Color

— Load Limit

Bound 1 [Hex): I[I
Bound 2 [Hex} IFFFFFFFF

—[ffzet Loaded S ymbols
% Default Offzet (Hex): +0
" Custom Offset [He): |Add x| o

Cancel | Help |

Figure 2-50: Load Symbol Options dialog box
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Select one or more of the symbols types to load. If you want to use the symbol
file with the Source window, you should click the Source Code check box.

You can enter a decimal number for the maximum number of symbols to load.
The maximum number of symbols that you can load is limited only by the
amount of memory available. The file loads symbols until the specified
maximum number of symbols is reached. Additional symbols are ignored, even
if they fall within the Bound 1 and Bound 2 range limits.

The Bound 1 and Bound 2 fields define the range of symbol addresses that will
be loaded. You can enter any hexadecimal values from O through FFFFFFFE.
Symbols with values outside of these limits are ignored and will not be loaded.

NOTE. If the lower bound of the range symbol is within the Bound 1 and Bound 2
limits and the higher bound is not, the entire symbol will be valid. However, if
the higher bound is within the Bound 1 and Bound 2 limits and the lower bound
is not, the entire symbol will be ignored.

Select either Default Offset or Custom Offset to apply an offset to the symbol
values. If you select Default Offset, the default offset is read from the source file
and applied to each symbol in the file as it is loaded. If you select Custom
Offset, you can add or subtract the specified offset value to each symbol in the
file as it is loaded. You can choose any 32-bit hexadecimal value from 0O to
FFFFFFFF.

When you enter bound values, enter the values without an offset value. If your
application adds an offset, you must subtract the offset value before you enter the
bound values.

Tektronix Logic Analyzer Family User Manual, Version 4.2 Software 2-53



Operating Basics

2-54 Tektronix Logic Analyzer Family User Manual, Version 4.2 Software



Y 4
Reference






Setup

This section describes how to set up the logic analyzer (LA), DSO modules, and
pattern generator modules.

For further details, particularly about selections available to you in windows and
dialog boxes, please refer to the online help.

Starting From the System Window

The System window gives an overview of the logic analyzer configuration,
arming, and triggering relationships. The System window also indicates whether
LA modules are merged and whether an external oscilloscope has been set up.
See Figure 3-1.

A black arrow from one module to another indicates that one module is set up to
arm another. Figure 3-1 shows the merged LA module arming the DSO module.

A module that is programmed to cause a system trigger has an indicator symbol
on the right edge of the module graphic.

Overlapped icons indicating Arm indicator System trigger indicator
merged modules
Eoeem | o]
Mainframe Yaternal
L —  3am
Logiz LM Digital AN Extermal £
Arialpzer Slots -6 Ogeiloscope Slots 72 [ Osciloscope
eon| 52 i eon| 52& T oon| 52 T
COff] Setup| Trig GOff| Setup| Trig GOff] Setup| Trig
JLa [Ds0 1 [Tos3012

|
1316|1123
R
431|113
—_—

ILisling1 IWavefDrm'I

Data source indicator

Figure 3-1: System window
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Opening Other Windows
from the System Window

3-2

Disabling Modules

Renaming Windows

Identifying Modules

You can use the System window as a quick navigation tool.

To open a module Setup, Trigger, or Program window from the System
window, click the Setup or Trigger button in the module icon.

B To open a data window from the System window, click the data window
button. See Figure 3-2.

B System [_ e =] I
Digital Eav oV Logic Sy
Ozcilloscope Analyzer
eon| GE| -p eon| G|
R L
COff| Setup| Tria QOff| Setup| Trig
Jpso s [asTART

1123
1123

I‘W’avefurm 1 IListing 1 IHistogram 1 IS ource 1

Figure 3-2: Opening a Waveform window from the System window

If you are not using a module, you can disable it by clicking the module On/Off
button. When you disable a module, make sure that no other trigger programs
depend on that module output.

You can rename the windows by selecting the current window labels and
overtyping. Names must be unique and are limited to the space available.

If you are unsure which physical module is represented by an icon, double-click
the icon to open its System Properties tab. This property tab lists information
about the module, including the mainframe slot numbers in which it is installed.
(Slot numbers are indicated on the mainframe.)
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Setting Up the LA Module

The primary function of the Setup window (see Figure 3-3) is to configure the
LA module for compatibility with the target system. This is where you specify
channel groups, set thresholds, and select the sample clock rate. Additional
selections configure the LA module for best compatibility with the type of data
you want to acquire.

Before you acquire and display data, you must first set up the LA module using
the LA Setup and Trigger windows. Together, these windows determine the data
to be acquired.

Each module has its own Setup window and Trigger window, and each is set up
individually. You should configure the Setup window before the Trigger window,
because some of the Setup window settings affect Trigger window selections.

L=
Clocking 2ns - Marnony Depth: {B7108864 -
Acouire: MNormal A Support Package: MNone

Frobes I Analog Feeds | Suppress | Define Compare: |
Group Name MSB Probe Channels LSB =
E] ©q  [cKo
43 G0 |30
A2 |20
-
Probe Channels / Mames
Probe |7 == b s b e 4 3 2 o |] e | = CLKQual
of 23 [ . . . . . . . CKo o~
of az e . . . . . . . XI
Al CK1
N D o v o Iy |
D3 ol >
5‘ In selected group
J Mot grouped Table Shows: |Channel Polarity
Channel Compare
LI In ather graup(s)

Figure 3-3: LA module Setup window

NOTE. If you intend to use merged modules, turn to page 3-73 for information
before you proceed with the setup procedure.
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Microprocessor Support

Setup

Performance Analysis
Setups

Sample Suppression

If you intend to use a microprocessor support package, load it before completing
the entries in the Setup window. The microprocessor support package configures

the Setup window for you.

To load a microprocessor support package, from the File menu, click Load
Support Package, select the support package you want to load, and then click

Load.

After loading the microprocessor support package, the LA Setup window shows
the channel definitions, channel groups, and clocking requirements for the
microprocessor support package. Figure 3-4 shows an example of the LA Setup

window after loading the QSTART support package.

[ Setup: QSTART =] B3
Clocking: IW 'l 4nz hd Memary Depth: |4194304 'l
Acquire; INnrmaI VI Support Q5TART

Group Hame MSE Probe Channels LSB ~
ddiess [31.0) |43 A2() A1() A0()
D ata (150 (D10D0)
Control [15-0) |RESET™ FREEZE AVEC™IRG_ANY_D BG_D™~ BGACK_L™ BERR™ HALT~ RMC™ R_\
D ataSize [7-0) |FC3FC2FC1 FCODSACKT™ DSACKD™ SIZ1 5120 =
Probe Channels / Mames
Probe 7 === |f = b 4 3 2 wemm || s | ] me—— | CLKQual
Xl 23 | Xnddr_3] 3¢ sddr_30 3¢ sddr_29 X 26 X sdai_21 Xsdddr_2¢ X sdi_20 X|sddr_2 CKo -~
X[ a2z | Xscdr 20 Xddr_22 Xladdr_21 Xladdr_20 X sdc_19 2] sde_14 3 sac_173¢]sae_16_[1Lro0T
K a1 | X153 143 scidr_11 X scddr_12 Xl sdar_11X0sddr_11 %] ader_5 X addr_d K1
X
i

ader_71 3¢ addr_g xl adeh_5 3] addr_4 xl Addr_3 xl Addr_] xl Addr_1 xl addr_0_|T_BUS, _

x| a0

ﬂ In selected group w

J Not grouped Table Shows: | Channel Polarity

ﬂ I ather groupls) Channel Compare

Figure 3-4: Setup window with the QSTART support package

For information about microprocessor support packages, refer to the online help
and to the instruction manual that came with your microprocessor support

package.

If you intend to do performance analysis with your LA module, you may want to
load a microprocessor support package that contains the predefined channel
setups and clocking setups. You can also define the channel and clocking setups
in the Setup window if you are not using a microprocessor support package.

You can use sample suppression to suppress or hide samples in the display
windows. This can help you focus on the data that you want to see. When you
suppress data samples, the suppressed samples are still in the acquisition
memory; you can turn the sample suppression off to view all the data.
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Click the Suppress button in the upper portion of the Setup window to display
the Sample Suppression dialog box (see Figure 3-5). Select one of the options to
define the data suppression. You can select a similar dialog box by right-clicking
in one of the display windows.

For more information on data suppression, refer to the online help.

Sample Suppression -LA 2 EE

After each acquisiion reset Sample Suppression to

= Show &ll acquired samples

o Sh-:nw |1 024 'I zamples around trigger
' Re-use existing suppression relative to ITIigger vl

’TI Cancel | Help |

Figure 3-5: Sample Suppression dialog box

Data Compare = Data Compare allows you to compare the current acquisition data of an LA
module to a known reference data. You can quickly view data differences and
similarities in a Listing or Waveform window using user-defined colors.

Selecting Channels for the Memory Compare. Choose the channels that you want
to compare in the LA Setup window by selecting Channel Compare in the Table
Shows box (see Figure 3-6). You can then compare all data channels, specific
channel groups, or individual channels by selecting the appropriate channels in
the Probe Channels/Names table.

After selecting the channels that you want to compare, click the Define Compare
button in the upper right of the Setup window to define the compare actions.
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: _lolx|
Clocking: IInlernaI j |4ns j Memony Depth: | 4134304 hd

Acquire: INormaI hd Suppart Mone
Probes... | Suppress... | Define Compare.. |

Group Name MSB Probe Ch I LSB =
CkO [0-0) |CKD
A3 (70 |[A3F0)
A2 [7-0) B2
>

Probe Channels / Mames |
Piobe |7 === |G = § 4 3 2 m==|] === | ==| ClLKQual
N N oo =
2 T 7 I 7 I I I Y
I 7 [ ™ ™ I o
| A0 | kY | K ] kY | K B =

ﬂ Compare Selected Group il Group Compare
J Don't Compare Table Shows: | Charinel Polarit
ﬂ Patial Compare il &l Compare

Figure 3-6: Selecting channels for memory compare

Defining Memory Compare Parameters. To enable the Define Compare dialog box
controls, select the Enable Data Compare check box as shown in Figure 3-7.
Select the reference data source in the list box; if the data source that you are
interested in does not appear in the list, click Add Data Source to browse for the
data source in the file system.

Define Compare - LA 1 HE

|::> [¥ Enable Data Compare

~ Reference Data Source

|Latod tiala 1 =l Add Data Saurce...

- Compare Data Hegion—l Partial Data aound Ref Begin j

Start I‘I jl Samples Ialtel Ref Begin 'l
Aind Compare |25 j Samples

D ata Source Ahgnmenl—l Using Begin or end j

Offset Acg Beain |1 ill Samples Ialtel Fief Beqgin 'l

— Owervi
Module Properties Acqg Source Fief Source
temary D epth; 32768 32768
About Data
HSamples 2000 2000
Start Compare Sample: 0 1
End Compare Sample: 24 25

Cancel AEpl Help |

Figure 3-7: Enabling data compare
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After you select the data source, define the amount of data that you want to
compare against. You can compare all data or a portion of the data by filling in
the appropriate information. You can also define the alignment of the data by
filling in the appropriate information. A summary of your setup displays at the
bottom of the dialog.

NOTE. After defining the compare setup, remember to select Show Compare in
the Listing Window or Waveform Window property page.

Guidelines for Memory Compare. There are a few guidelines that you should be
aware of when using memory compare:

®  You must select the Enable Data Compare check box in the Compare
Definition dialog box (see Figure 3-7).

B Acquisition modules and reference modules must be the same width.

B Specify the color of compare data in the Listing Window or Waveform
Window property sheet, or use the default colors.

B You can search for data differences or data equalities.
®  You can use memory compare with repetitive acquisitions.

B You can compare only the main logic analyzer data; you cannot compare
glitch data, disassembler group data, or MagniVu data.

NOTE. Although you cannot compare disassembler group data directly, you can

compare the raw data (before it is disassembled) by using the channel groups as
defined in the Setup window. To view these channel groups in a Listing window,

use the Add Column toolbar button to add the channel group to the window.

Clocking Use Clocking to specity the clock(s) used to sample data. You have several
clocking choices, depending on the module you are using; Internal, Internal 2X,
and External are available for all module types. If you are using a TLA7Axx
module, you can also choose Internal 4X, External 2X, External 2X Double Data
Rate (DDR), External 4X, and Source Sync clocking. Custom clocking is also
available, regardless of your module type, if a microprocessor support package
has been loaded. Your clocking choice determines further clocking selections.

Internal Clocking. Internal (asynchronous) clocking uses the LA module internal
clock to determine when to sample data. Typically, internal clocking is used for
timing analysis (waveform data).
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3-8

I Setup: LA 1 -|O] =]
Clacking: bl I - bemary Depth: |41 54304 'l
Acouire: I Marmal ~ | SLpport MNone

When you choose Internal clocking, the only additional selection is the clock rate
in the next field.

Because the internal clock signal is asynchronous to the target system, be careful
to select a sample period that is considerably faster than the data rate of your
target system.

For more information on Internal clocking, refer to the online help.

Internal 2X Clocking. When you use Internal 2X clocking mode, you trade half the
input channels for twice the sampling speed and acquisition depth. You can use
Internal 2X clocking mode with triggering and in both Listing and Waveform
windows.

If you are using a TLA7Lx/Mx/Nx/Px/Qx module, Internal 2X clocking provides
a sample rate of 2 ns; using a TLA7Axx module, Internal 2X clocking provides a
sample rate of 1 ns.

=10l
Tns - tdemary Depth: |8?1DBBB4 VI

Acouire: INormaI VI Suppont Package:  Mone

Clacking:

Internal 4X Clocking. Available only for TLA7Axx modules, Internal 4X clocking
mode allows you to trade three quarters of the input channels for four times the
sampling speed and four times the acquisition depth. Available only in
TLA7Axx modules, Internal 4X clocking provides a sample rate of 500 ps.

=10l
IEDDpS 'l tMemory Depth: IE?‘I 0a864 'l
Acouire: INormaI VI Support Package: MNone

Clocking: Internal

External Clocking. External (synchronous) clocking synchronizes data sampling
with the clock of the target system so you can be more selective about the data
you sample. This type of clocking is best for state analysis (listing data).
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When you select External clocking, you have the option of further selections to
define the sample clock. To do so, you create clocking definitions in the
Clocking dialog box. Clocking definitions qualify when data is sampled. The
definitions consist of a Boolean combination of events, linking clock and
qualifier lines. Data is sampled and stored in memory only when the clock
definition is true.

Fdare... | Memaory Depth: |4‘|943|:I4 "'l
Aequine: IN-:-lmaI vi Support LSTART

Clocking:

For more information on External clocking, refer to the online help.

Advanced Clocking. Advanced clocking is available only if you select External
clocking. Use advanced clocking to set up multiple-phase clocking, probe
demultiplexing, and other clocking features. Multiple-phase clocking specifies
two different sample clock equations and assigns an equation to separate probe
groups in order to clock in sample data. You can also sample data from different
channel groups at different points in time, relative to the sample clock through a
variable setup and hold window.

For more information on advanced clocking, refer to the online help.

External 2X Clocking. Available only in TLA7Axx modules, External 2X clocking
allows you to acquire listing data at twice the normal maximum sample
frequency of the logic analyzer. However, this increased speed and acquisition
depth come at the expense of half the acquisition input channels. When you use
External 2X clocking, you acquire data using a clock rate of up to 800 MHz from
the test system. The maximum data rate in 2X clocking mode is 800 MB/s.

You can access advanced 2X clocking functionality by clicking the More button.
The 2X Clocking dialog box allows you to select the active clock edge and to
align data, in relation to the specified clock edge, for each channel group. The
Setup/Hold window graphic illustrates your clock edge and data alignment
settings.

External 2X DDR Clocking. Available only on TLA7Axx modules, External 2X
Double Data Rate (DDR) clocking allows you to acquire data on both the rising
and falling clock edges at clock rates up to the normal maximum sample
frequency of the logic analyzer. In this mode, half the logic analyzer input
channels are traded for twice the data rate and twice the acquisition depth. When
you use External 2X DDR clocking, you acquire data using a clock rate of up to
450 MHz from the target system. The maximum data rate in External 2X DDR
clocking mode is 900 MB/s.
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3-10

You can access External 2X DDR advanced clocking functionality by selecting a
clocking type of External 2X and then clicking the More button. Note that you
must specify a clock edge of Both. The 2X Clocking dialog box also allows you
to align the data, in relation to the specified clock edge, for each channel group.
The Setup/Hold window graphic illustrates your clock edge(s) and data
alignment settings.

External 4X Clocking. Available only in TLA7Axx modules, External 4X clocking
acquisitions allow data to be acquired and displayed at approximately three to
four times the normal maximum sample frequency of the logic analyzer. In this
mode, three quarters of the logic analyzer input channels are traded for three to
four times the speed and four times the acquisition depth. The reason that the
External 4X clocking mode data rate does not always increase by four times
above the base synchronous rate of the logic analyzer is that the Setup/Hold
window requirements of the logic analyzer may come into play. Setup and hold
requirements on the acquisition data can limit the acquisition rate to a lesser
value than if it were constrained by the maximum clock speed alone. When you
use External 4X clocking, you acquire data using a clock rate of up to 625 MHz
from the test system. The maximum data rate in 4X clocking is 1.25 GB/s.

External 4X clocking mode is a double data rate (DDR) clocking mode, which
means that the two acquisition samples are taken per clock cycle. This means
that the data rate of the acquisition is double the rate of the clock signal that is
driving it.

You can access advanced 4X clocking functionality by clicking the More button.
The 4X Clocking dialog box allows you to select the active clock edge and to
align data, in relation to the specified clock edge, for each channel group. Each
channel group may be assigned a second edge delay to skew the second data
capture in relation to the first. The Setup/Hold window graphic illustrates your
clock edge and data alignment settings.

Source Synchronous Clocking. Available only in TLA7Axx modules, Source
Synchronous clocking sends a strobe signal with the data signal. The data is then
synchronized with the strobe signal instead of the clock signal. The sending
device is responsible for synchronizing the data with the strobe signal; the
receiving device is responsible for latching the data inside of itself and for
resynchronizing the data with the clocking state machine (CSM) heartbeat clock.
This type of clocking is best used for state analysis when you want to see the
data signal in relation to the CSM heartbeat clock.

You can access advanced source synchronous clocking functionality by clicking
the More button. The Source Synchronous Clocking dialog box allows you to
specity edge detectors, define clock groups, create clocking equations, demulti-
plex data, and set up advanced clocking parameters. Once you have set all
clocking parameters, you can click the Validate button to check that no source
synchronous click setting conflicts exist.
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Figure 3-8 shows a typical DDR SDRAM read data transfer, illustrating how the
source synchronous clocking feature can be used to acquire data from a Double
Data Rate (DDR) SDRAM memory bus.

T3 T3n T4 T4n T5 T5n

T T T T T T
Bank, Bank,
ADBRESS Coln /)@( Colb W W W /)@

o —————— L
oo — O T
DON'T CARE TRANSITIONING DATA

Figure 3-8: Typical DDR SDRAM consecutive READ bursts

Tables 3-1 and 3-2 show the channel assignments and group definitions,
respectively, for the SDRAM signals contained in Figure 3-8.

Table 3- 1: Channel assignments

SDRAM signal Logic Analyzer channel
DQS CKi1

CK CKo

CASH# CK3

WE# CKk2

CSi# C2(3)

RAS# C2(2)
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Table 3-2: Group definitions

Group name Channels
CLK CK
{ CMD R CS#, RASH, CAS#, WE#
Control 1 cmp_w CS#, RAS#, CAS#, WE#
ADD R E3(7-0), E2(7-5)
Address =
ADD W E1(7-0), EO(7-5)

As indicated in Figure 3-8, DQS is used as the strobe and the data is edge
aligned with the strobe. For the read cycle, the setup/hold window must be set to
sample the data after the strobe edge occurs (rising and falling edge). In the
example, the CAS latency is three clock cycles, so the pipeline delays for the
common clock signals need to be adjusted to three in order to put all the
information on the same clock sample.

The signals that comprise the COMMAND group are CS#, RAS#, CAS# and
WE#. A truth table for these signals is shown in Figure 3-9. To simplify the
example, two of the four signals are used as qualifiers to enable the read data to
be captured at the correct time. CAS# is assigned as QUAL2 and WE# is
assigned as QUALS3. Because only two qualifiers are used, a few AUTO
REFRESH, SELF REFRESH or LOAD MODE REGISTER cycles may be in
the acquisition data.

TRUTH TABLE 1 - COMMANDS

(Note: 1)

NAME (FUNCTION) CS# [RASH#CAS# WE# ADDR |NOTES
DESELECT (NOP) H X X X X 9
NO OPERATION (NOP) L H H H X 9
ACTIVE (Select bank and activate row) L L H H | Bank/Row 3
READ (Select bank and column, and start READ burst) L H L H Bank/Col 4
WRITE (Select bank and column, and start WRITE burst) L H L L Bank/Col 4
BURST TERMINATE L H H L X 8
PRECHARGE (Deactivate row in bank or banks) L L H L Code 5
AUTO REFRESH or SELF REFRESH L L L H X 6,7
(Enter self refresh mode)

LOAD MODE REGISTER L L L L Op-Code 2

Figure 3-9: Truth Table for the COMMAND group
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A typical DDR SDRAM write data transfer is shown in Figure 3-10. The DQS
signal is again used as the data strobe, but this time the data is center-aligned
with the strobe. For the write cycle, the setup/hold window must be set to sample
the data centered around the strobe edge (rising and falling edge). The same set
of COMMAND group signals are used to determine the write cycle (see Figure
3-9). The qualifier assignments are the same for capturing the write data.

- ™ T2 T2n T3 T3n T4 T4n T5
« A XA A A AN A X
COMMAND NOP @( WRITE W NOP W NOP W NOP @
0 ] ! ! ! 1 1 1

I I ]
Bank, Bank,
aporess /B U BT DT T

DQs Mj T_; \_f; Y
b 77 B TR R R E EX I
ou ZTITIN. A0 LA LD A0 10 A0 s
DON T CARE TRANSITIONING DATA

Figure 3-10: Typical DDR SDRAM consecutive WRITE to WRITE

In order to capture the DDR read and write data, use the Source Sync clocking
capability of the TLA7Axx module. To begin, set up the Edge Detectors tab. As
indicated in this tab, Edge Detector 0 is the CSM Heartbeat Clock, which means
that Edge Detector 0 is the master clock that clocks the Clocking State Machine
and the Clock Group Complete sections. You have a total of four Edge Detec-
tors, each with four clocks (rising and falling edge) from which to choose.
Assign the rising edge of the DDR SDRAM clock to Edge Detector 0, CKO
rising edge. For Edge Detector 1, assign the DQS signal to Edge Detector 1,
CK1 rising and falling edge. Figure 3-11 shows the edge detect assignments.
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Source Synchronous Clacking - LA 1 I

Edge Detectarz | Clack, Gmupsl Sample Clocksl Group Claocking | Frobe Demuxl

Edge Detector 0 Edge Detector 1 Edge Detector 2 Edge Detector 3
Choose Clock Edges: Choose Clock Edges: Choose Clock Edges: Choose Clock Edges:
[v| .+ CKO ] CKD 1.7 CKO ]« CKO

]~ CKD ]~ CKD ]~ CKO ]~ CKD
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Figure 3-11: Edge Detector assignments

The Clock Groups tab has three Clock Groups from which to choose, each with
four Edge Detectors. Clock Group 0 and Edge Detectors 0 and 1 are used for the
example application. The DDR SDRAM clock and the DQS strobe comprise
Clock Group 0. Figure 3-12 shows the clock groups selection.

Source Synchromouz Clocking - LA 1 I
Edge Detectars  Clock Groups | Sample Clocksl Group Claocking | Frobe Demuxl

—Clock Group0——————— —Clock Growp 1——————— — Clock Group 2

Choose Edge Detectors:
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Walue: |255 3:

Choose Edge Detectors:
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] Edge Detectar 1
1 Edge Detectar 2
1 Edge Detectar 3
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& Counter ' Timer
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To sample the read and write data at the correct time, use the Sample Clocks tab.
Figure 3-13 shows the Sample Clock equation. The first equation is to properly
sample the read data, the second equation is to properly sample the write data.
These equations qualify the data so that the read and write transactions on the
DDR SDRAM bus are sampled. The Sample Clocks tab supports up to four
sample clocks. Each sample clock can have up to four OR’d Clock Groups, with
each Clock Group containing up to three AND’d qualifiers.

Source Synchronous Clacking - LA 1 I

Edge Detectars | Clock Groups  Sample Clocks | Group Claocking | Frobe Demuxl

Sample Clack: |Sarnple Clack 0 =]

[Clock Group 0 > |/ AND Jim2 =] &ND o3 -] A =
OR  [Clock GroupD | AND |32 =] &Np s ] &D | =]
oR | -

MNate: Sample Clack O is the Faster Sample Clock

Cloze I Help I

Figure 3-13: Sample Clocks equations

The Group Clocking tab is where you input the Edge Detector, Setup/Hold
Window, Clock Group, Pipeline Delay and Sample Clock for all of the groups.
Figure 3-14 shows the selections made in the sample application to properly
capture both the read and write data on the DDR SDRAM bus.

To properly capture and align the common clock groups for both read and write,
two COMMAND and two ADDRESS groups are set up. Remember, the read
cycle has a CAS latency of three, so these two groups must be delayed three
clock cycles to line up with the read data. For the write cycle, there is a delay of
only one clock cycle. To be able to sample the same data at two different time
clock pipeline delays, it is necessary to set up the groups as demultiplexed pairs.
The setup/hold time relative to the common clock for these groups is always
center-aligned.

For the DATA, you must have different setup/hold sample times. For the read
cycle, the data is edge-aligned with the strobe; for the write cycle, the data is

center-aligned with the strobe. DATA also has to be setup as a demultiplexed

pair. Figure 3-14 shows the programming to capture the read and write DDR
SDRAM data.
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€ Use Max Sync Speed 16.125r: 0z 8.37Bn:
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Figure 3-14: Group Clocking programming

Use the Probe Demux tab to select which groups of channels are to be demulti-
plexed. You have the choice of a two-way or four-way demultiplex. In addition,
you have the option to select all channels or clear all channels. Figure 3-15
shows which channel groups are selected for a two-way demultiplex.

Source Synchronous Clacking - LA 1 I

Edge Detectors | Clock Gmupsl Sample Clocksl Group Clocking — Probe Demux I

Select Probe Charnel

B3> ET
EZ- EN
£33 D3
D IR Select &l
A1 D1 4|
A0 DO
e Clear &l |
[ C23C0

CK3-» 62

CK2- 032 =
CK1- 00 =l

|»

Demux Type
& 24 dernus
= 4 dernu

Cloze I Help I

Figure 3-15: Probe Demux channel selections
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The preceeding source synchronous clocking application example is intended to
familiarize you with this clocking capability. In addition, you should consider the
following functional clarifications:

®  The source synchronous clocking hardware in the TLA7Axx is designed to
wait for Clock Group Complete (CGC) signal before it clocks the CSM. If
the data strobe straddles the master clock, meaning that one edge occurs
before the master clock and one edge occurs after the master clock, then that
sample will be clocked in on the next edge of the master clock.

B You must verify that the strobe edge is not time aligned with the master
clock, because this will cause the CGC signal to shift from one master clock
cycle to the next. This will cause the data sample presentation to dither back
and forth.

®m  The separation of edges on the same signal is limited to no less than 2.2 ns
(450 MHz).

®  The frequency of the strobes must be equal to or less than the frequency of
the master clock or the input data pipeline will overflow.

For more details on Source Synchronous Clocking, refer to the online help.

Custom Clocking. Custom clocking is used only with microprocessor support
packages. Custom clocking enables and disables a variety of microprocessor-spe-
cific clock cycle types (such as DMA cycles). For more information, see the
instructions that came with your microprocessor support package.

Selecting the Acquisition ~ Use Acquire to select the acquisition mode, which determines the type of data to
Mode  select and store. You can store channel data only, glitch data, setup and hold
violation data, or blocks of data around requested samples.

_ (ol x|
|rkernal bl B33 - bemary Depth: I 4194304 hd |
Acouire: INurmaI "| SLpport MNone

I Setup: LA 1

Clocking:

Normal Mode. Normal mode stores only the requested channel data.

Glitch Storage Mode (Internal Clocking Mode Only). Glitch mode captures glitch
data and regular data for each data channel. You must select internal clocking for
Glitch mode to be available. Glitch storage is independent of glitch events.
Therefore, you can trigger on a glitch even when you are not storing glitches.
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3-18

Setting Memory Depth

Grouping Channels

Glitch mode limits memory depth to half of the maximum depth and limits the
sample period to 10 ns or greater for TLA7Lx/Mx/Nx/Px/Qx modules and 4ns
for TLA7Axx modules. However, there is no trade-off in channels, which avoids
changing probe connections.

Setup/Hold Violation Storage Mode (External, Source Synchronous, and Custom
Clocking Mode Only). Setup/Hold mode captures setup and hold violations for
each channel. You must select External or Source Sync clocking for Setup/Hold
mode to be available.

Setup/Hold mode limits memory depth to half of the maximum depth and limits
the maximum synchronous speed to half its normal maximum value.

Blocks Mode. Blocks mode stores a block of approximately 60 samples around
each qualified sample. In Blocks mode, only channel data is stored. If you store
blocks, they will override other forms of data qualification. All samples in the
block are always stored. Block size is fixed in the hardware and cannot be
changed.

Use Memory Depth to specify the total number of samples acquired by the LA
module. If you do not require full memory depth, select a lesser value because
you will have less data to search to find the data of interest.

For a given memory depth there is a tradeoff between the clock sample rate and
data record length. (A faster sample rate provides a shorter time window, but
with higher resolution.)

NOTE. If you select Glitch or Setup/Hold mode, the maximum memory depth is
limited to one half the normal value.

I Setup: LA 1 -|O] =]
Clocking:  HIEGE] bl B33 bemary Depth: I 4194304 hd |
Acouire: INurmaI "| SLpport MNone

Use channel grouping to organize the LA probe channels to match the configura-
tion of the target system. Depending on your application, match the channel
groups to the address and data buses, or other channels of interest. Then name
the channel groups for easy identification.
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Any number of groups can be created. Each group can contain any combination
of module channels; the application does not restrict you from repeating channels
from various groups.

When using group range events (range recognizers), the probe groups and probe
channels must be used in hardware order. That is, probes must be used from the
most-significant probe group to the least-significant probe group, based on the
following order:

C3C2C1 COE3E2E1E0A3A2D3D2 A1 A0D1 DO Q3 Q2 Q1 Q0 CK3
CK2 CK1 CKO

The probe channels must be used from the most-significant channel to the
least-significant probe channel, based on the following order:

76543210

In Internal 2X Clocking and External 2X Clocking mode, half of the probe
channels are designated as the demux destination, indicating that they are
unavailable as a source (see Figure 3-16).

NOTE. If a microprocessor support package is loaded, do not change or delete
the default channel groups. Doing so can cause an inaccurate analysis.
However, you can still add and delete new channel groups.

If you are using a TLA7Axx module, both Internal and External 4X Clocking
modes designate three-quarters of the probe channels as the demux destination to
indicate they are unavailable as a source. In Source Synchronous and External
Clocking mode, the source channel availability depends on whether you have set
up probe channel demultiplexing.

For more details on Source Synchronous clocking, refer to the online help.

If a microprocessor support package is loaded, the channel groups are defined for
you.
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Figure 3-16: Source and destination probe channels in Internal 2X Clocking mode

Channel Group Name. Each channel group must have a name. Use the default
name or enter another name. There is no limit to the number of groups. Channel
groups defined in the channel grouping table are used in other displays and setup
controls. The order of the groups in this table determine the order of presentation
in other windows.

For each group name, list all the probe channels that make up the group. The
group names are listed in the left column of the table. The individual probe
channels that make up each group are listed in the right column of the table. The
center column of the table lists the number of channels in a group (where a zero
refers to bit 0). For example in Figure 3-17, the Address group is made up of 32
channels, with channel 31 as the most-significant bit (A3-7) and channel O as the
least-significant bit (A0-0).

Probe Channels/Names Table. Use the Probe Channels/Names Table to enter
names for individual channels, add and remove channels from a group, or change
polarity of individual channels.
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Figure 3-17: Channel grouping table in the Setup window

Analog Multiplexing  Available only in TLA7Axx modules, analog multiplexing allows you to observe
multiple digital data signals on a DSO using multiple analog channel outputs.

You can assign data signals in one of two ways: You can either select an

individual channel and assign it to an analog output, or a group of channels and
then select the analog outputs to which you want them assigned. Setting up

analog multiplexing involves specifying signal routing between the LA module
and the DSO module or external oscilloscope.

(]

Physical Module:

—Analog Output Attenuatio

@ 10 Attenuation (-2.54/ to +5 0% input range) Help
" BxX Attenustion (-1.5% to +2.5V input rangs)
~SelectChannelis) | - Assign To i~ Current Routing
By Group < Analog Output Analog Feed Destination
CH1 CH1: CKD -MNone -
cH2 CH2:  A3[7) -None -
CH3 CH3:  AlB) -MNane -
CHA CH4  AIE) ~Nane -
System Intar-probing
—Analog Feed Cycling
™ CH1
" cHe « < | > | » |
© CcH3
™ Exclude channels assigned to unchecked outputs
I CH4

Figure 3-18: Analog Feeds dialog box
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The Analog Feeds dialog box controls which digital data signals (via the probed
channels on which they reside) are assigned to each analog output. In addition,
you can specify an attenuation level, based on the amplitude of the signals being
assigned. You can also choose the manner in which digital channels are
displayed: by group, probe, or name.

Selecting individual channels.

After you have chosen a digital channel to output, you can assign it to an analog
output channel by clicking a channel button under Assign To. You can confirm
that the digital signal was correctly routed by reviewing the analog feed
assignment information under Current Routing.

Selecting groups of channels.

When you select multiple digital channels to output, you can assign them to one
or more analog output channels by selecting the check boxes associated with the
target channels. If you are interested in more digital channels than you have
analog outputs, use the Analog Feed Cycling buttons to cycle the selected digital
channels through the selected analog outputs. You can additionally direct the
system to exclude channels assigned to unchecked outputs from being re-
assigned, which guarantees that channel assignments to unselected outputs are
preserved. To do so, select the check box labeled Exclude channels assigned to
unchecked outputs.

NOTE. The system only reassigns digital channels when the assigned digital
channel is a member of the channels that you specified for output in Selected
Channel(s) and the analog output channel to which the digital channel is
assigned is not selected.

If one or more of the selected digital channels are already assigned to an analog
output, those channels are highlighted in yellow under Select Channel(s). As you
feed digital channels to the selected analog output channel(s), this highlighting
changes to reflect current channel routing.

The Current Routing group box displays read-only details about the assignment
of individual data signals to analog outputs and the oscilloscope input ports to
which they are physically connected. It additionally provides a System Inter-
probing button that you can click to reassign oscilloscope destination of data
signals.
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NOTE. The Analog Feeds dialog box retains the channel assignment settings for
each TLA7Axx module represented in the System window. When using Analog
Feed Cycling functionality, you can assign channels using one of the control
buttons, then close the Analog Feeds dialog box. Later, when you reopen the
dialog box, you can resume assigning digital channels to analog outputs.
However, if you change either the setup of groups or any channel names, channel
assignment settings will return to defaults the next time the Analog Feeds dialog
box is opened.

Because the TLA application cannot sense probe physical connect/disconnects, it
is unable to manage logic analyzer or oscilloscope mapping automatically.
Therefore, you must use the System Inter-probing dialog box to manually
specify which connectors between the logic analyzer and oscilloscope are fitted
with probe connections.

NOTE. Only TLA7Axx modules, DSO modules, and external oscilloscopes can be
displayed in the System Inter-probing dialog box.

When an inter-probing connection is created, the system changes the oscillo-
scope signal name to reflect the logic analyzer channel that is feeding it. The
signal name is visible in both the DSO Setup channel tabs and the waveform
element label. The system also automatically adjusts the time alignment dialog
to incorporate whatever signal path delay is determined for the oscilloscope
individual signal. The delay is a single time value, based on both the cable length
and the particular path of the logic analyzer channel feed.

Signal routing from the logic analyzer.

You can specity the logic analyzer channel through which probe data is sent to
the currently selected oscilloscope channel using the Route from LA dialog box.
To display this dialog box, select Route from LA from the context menu
associated with a selected oscilloscope channel waveform.
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Figure 3-19: Route from LA dialog box

The Route from LA dialog box displays the currently defined inter-probing
connection and its feed for the oscilloscope channel. This item cannot be selected
and is displayed for information purposes only. If no inter-probing connection is
defined for the oscilloscope channel, the field is empty.

Click the System Inter-probing button to change the contents of the scroll list by
adding or changing the connection to the logic analyzer.

Click the Select Channel button to select a new logic analyzer channel to feed
the inter-probe connection to the oscilloscope channel. This button is made
available when an inter-probe connection is defined.

Signal routing to the oscilloscope.

You can specify the inter-probe connector and DSO channel through which 